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Legal Information

Legal Information

© 2019 AVEVA Group plc and its subsidiaries. All rights reserved.

No part of this documentation shall be reproduced, stored in a retrieval system, or transmitted by
any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written
permission of AVEVA. No liability is assumed with respect to the use of the information contained herein.

Although precaution has been taken in the preparation of this documentation, AVEVA assumes no
responsibility for errors or omissions. The information in this documentation is subject to change without
notice and does not represent a commitment on the part of AVEVA. The software described in this
documentation is furnished under a license agreement. This software may be used or copied only in
accordance with the terms of such license agreement.

ArchestrA, Aquis, Avantis, DYNSIM, eDNA, EYESIM, InBatch, InduSoft, InStep, IntelaTrac, InTouch,
PIPEPHASE, PRiSM, PRO/II, PROVISION, ROMeo, SIM4ME, SimCentral, SimSci, Skelta, SmartGlance,
Spiral Software, Termis, WindowMaker, WindowViewer, and Wonderware are trademarks of AVEVA and/
or its subsidiaries. An extensive listing of AVEVA trademarks can be found at: https://sw.aveva.com/
legal. All other brands may be trademarks of their respective owners.

Publication date: January 2019
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Introduction

Introduction

InduSoft Web Studio (or IWS, for short) is a powerful, integrated tool that exploits key features of
Microsoft operating systems and enables you to build full-featured SCADA (Supervisory Control and Data
Acquisition) or HMI (Human-Machine Interface) programs for your industrial automation business.

This InduSoft Web Studio Quick Start Guide is intended for individuals using IWS for the first time. This
publication will help you quickly familiarize yourself with the basic functions of IWS.

Page 5



Introduction

Conventions used in this documentation

This documentation uses standardized formatting and terminology to make it easier for all users to
understand.

Text conventions

This documentation uses special text formatting to help you quickly identify certain items:

¢ Titles, labels, new terms, and messages are indicated using italic text (for example, Object Properties).

* File names, screen text, and text you must enter are indicated using monospace text (for example, D:
\Setup.exe ).

* Buttons, menu options, and keyboard keys are indicated using a bold typeface (for example, File menu).
In addition, this documentation segregates some text into Tip, Note, and Caution boxes:
¢ Tips provide useful information to save development time or to improve the project performance.

* Notes provide extra information that may make it easier to understand the nearby text, usually the
text just before the note.

e Cautions provide information necessary to prevent errors that can cause problems when running the
project, and may result in damage.
Mouse and selection conventions

Because most PCs used for project development run a version of Microsoft Windows with a mouse, this
documentation assumes you are using a mouse. Generally, a PC mouse is configured for right-handed
use, so that the left mouse button is the primary button and the right mouse button is the secondary
button.

This documentation uses the following mouse and selection conventions:

¢ Click and Select both mean to click once on an item with the left mouse button. In general, you click
buttons and you select from menus and lists.

* Double-click means to quickly click twice on an item with the left mouse button.
¢ Right-click means to click once on an item with the right mouse button.

¢ Select also means you should use your pointing device to highlight or specify an item on the computer
screen. Selecting an item with a touchscreen is usually the same as selecting with a mouse, except
that you use your finger to touch (select) a screen object or section. To select items with your keyboard,
you typically use the Tab key to move around options, the Enter key to open menus, and the Alt key
with a letter key to select an object that has an underlined letter.

¢ Drag means to press down the appropriate mouse button and move the mouse before releasing the
button. Usually an outline of the item will move with the mouse cursor.

Windows conventions

This documentation uses the following Windows conventions:

* Dialogs are windows that allow you to configure settings and enter information.

¢ Text boxes are areas in dialogs where you can type text.

¢ Radio buttons are white circles in which a black dot appears or disappears when you click on the
button. Typically, the dot indicates the option is selected or enabled. No dot indicates the option is
cleared or disabled.

Check boxes are white squares in which a check (¥ Itba) appears or disappears when you click on it
with the cursor. Typically, a check F indicates the option is selected or enabled. No check I indicates
the option is cleared or disabled.

¢ Buttons are icons in boxes appear "pressed" when you click on them.
* Lists are panes (white boxes) in windows or dialogs containing two or more selectable options.
¢ Combo boxes have arrows that, when clicked, show part or all of an otherwise concealed list.

* Dockable windows are windows that you can drag to an edge of the interface and merge with that
edge.
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About this software

InduSoft Web Studio (or IWS, for short) is powerful software for developing HMI, SCADA, and OEE/
Dashboard projects that can be deployed anywhere.

Each IWS project consists of:
* A project tags database to manage all run-time data, including both internal variables and I/O data;

e Configurable drivers to communicate in real-time with programmable logic controllers (PLCs), remote
1/0O devices, and other data-acquisition equipment;

* Animated human-machine interface (HMI) screens and overall equipment effectiveness (OEE)
dashboards; and

¢ Optional modules such as alarms, events, trends, recipes, reports, scriptable logic, schedulers, a
project security system, and a complete database interface.

After you develop your project, you can either run it locally on your development workstation or download
it to a remote computer and run it there. The project runtime server processes I/O data from connected
devices according to your project parameters and then reacts to, displays, and/or saves the data.

Product features
ActiveX and .NET

Use third-party controls to enhance your project. This software is a container for ActiveX
and .NET controls. Add functionality such as browsers, media players, charting, and other
tools that support the ActiveX and .NET interface standards.

Alarms

In addition to all of the alarm functions you would expect, this software also sends alarms
using multi-media formats like PDF. Use remote notification to have alarms sent right to
your email inbox, a printer, or a smartphone! Alarms are real-time and historical, log data in
binary format or to any database.

Animation

This software gives you great command over graphics. Paste images, and even rotate

them dynamically. Fill bar graphs with color, or adjust the scale of objects with easy-to-
use configuration. Other animations include "command" (for touch, keyboard and mouse
interaction), hyperlink, text data link, color, resize (independent height and width), position,
and rotation (with custom rotation point).

Database

Connect to SQL databases (MS SQL, MySQL, Sybase, Oracle), MS Access and Excel, and
ERP/MES systems (including SAP), even from Windows Embedded. Flexible enough to have
a built-in interface without the need to know SQL (for trends, alarms/events, grid and other
objects), or use any SQL statement you need anywhere you need it.

Drivers

This software includes over 240 built-in communication drivers for most PLCs, temperature
controllers, motion controllers, barcode/RFID readers, and other devices. Use these built-in
drivers without the need for OPC servers (but are an optional connection method).

Email

Send email via SMTP to any desktop or mobile device. Get real-time information on alarms,
process values, and other events. This software supports SSL encryption allowing the use of
third-party providers such as Gmail.

Events

This software offers traceability for operator initiated actions or internal system activity. Log
events such as security system changes (user logon or off), screen open/close, recipe/report
operations, custom messages and system warnings. Also any tag value changes including
custom messages.

FDA Traceability
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Take advantage of built-in traceability and e-signature features to create projects that fully
comply with U.S. Food and Drug Administration regulations (Title 21 CFR Part 11). These
features are often used in food and pharmaceutical applications, but they can be used in
any application where traceability is required.

FTP

Automatically upload or download files during run time to/from remote storage locations
using FTP and flexible scripting functions. Configure FTP via scripting or the included
configuration interface.

Graphics and Design Tools

Create powerful screens to meet any application need using the improved tools in our
graphic interface. Combine built-in objects to create any functionality required. Store
graphics in the symbol library for future use. Easily make projects across a product line
share a consistent "look and feel".

Historical Performance

We have optimized the trend history module and designed it to load millions of values from
SQL relational databases with high performance, with built-in data decimation in the Trend
Control. Easy-to-use tools provide quick access to Statistical Process Control (SPC) values
without any need for programming.

Intellectual Property Protection

Screens, documents, scripts and even math worksheets can be individually password
protected. This prevents unauthorized viewing or editing of your corporate custom
functionality. Protect the entire project with just a few mouse clicks.

Multi-Language

Develop your project in one of many development languages, including English, Portuguese,
German, and French.

OPC

As an alternative to the built-in drivers for direct communication with PLCs, you can also
use any of several different versions of OLE for Process Control (OPC) to manage your
devices. This software includes support for "classic" OPC DA (client or server), OPC UA
(client or server), OPC XML-DA (client only), and OPC HDA (server only).

PDF Export

Send Alarms, Reports, or any file (including .doc or .txt) to a production supervisor, quality
manager, or maintenance staff using the included PDF writer.

Recipes

Save time and maintain consistency by automating part parameters or productions
quantities with any triggering event.

Redundancy
For critical applications where data is vital, this software supports web server, database and
overall system redundancy.

Reports

Create clear, concise reports in text format, graphical RTF, XML, PDF, HTML, and CSV, or
integrate with Microsoft Office. Get the data you need, in the format you need it, to make
informed decisions, fast.

Scalable

Develop once and deploy anywhere, on any currently supported version of Microsoft
Windows.

Scheduler

Schedule custom tag changes on date/time, frequency, or any trigger. Use this for
simulation, to trigger reports or other functionality at a particular time of day, or even to
trigger driver worksheets to read/write at a scan rate you choose.
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Scripting
Two powerful scripting languages are supported. Use built-in functions or use standard

VBScript to take advantage of widely available resources. Both can be used simultaneously
to give you the functionality you need.

Security

This software provides support for group and user accounts, e-signatures, and traceability,
as well as support for Lightweight Directory Access Protocol (LDAP). Integrate your project
with your Active Directory, including Active Directory Application Mode (ADAM).

SSL Support for Emails

Native support for Secure Socket Layer (SSL), which makes it easy and secure to send
emails from this software using third-party tools such as Gmail!

Standards

Take advantage of common industry standards to develop projects that are compatible with
any format. TCP/IP, ActiveX/.NET, OPC (client and server), COM/DCOM, OLE, XML, SOAP,
and HTML are all supported.

SNMP

Easily configure managed networked devices on IP networks (such as switches and routers)
using incorporated SNMP configuration commands and an easy-to-use configuration
interface.

Symbols

An extensive library of pre-made symbols features push buttons, pilot lights, tanks, sliders,
meters, motors, pipes, valves and other common objects. Use the included symbols in your
project, modify existing symbols to suit your needs, or create your own from scratch. Plus
support for third-party symbol libraries and graphic tools.

Tags Database

This software features an object-oriented tags database with boolean, integer, real, strings,
arrays, classes (structures), indirect tags, and included system tags.

Thin Clients

Remotely view project screens on several different types of thin clients. Use the standalone
Secure Viewer to acheive the greatest security on plant-floor stations. Use the Internet
Explorer-based Web Thin Client to achieve the greatest flexibility on Windows desktops.
Or use the HTMLS5-enabled Mobile Access to access your project from almost any other
computer or mobile device.

Trends

Real-time and Historical trends are supported. Log data in binary format or to any database
locally and remotely. Color or fill trends with graphic elements to enhance clarity of data.
Date/Time based or numeric (X/Y plot) trends give you the flexibility to display information
that best suits your project.

Troubleshooting

Quickly debug and verify a project using local and remote tools for troubleshooting,
including status fields, Database Spy and LogWin. Capture screen open and close times,
see communications in real-time, and messages related to OPC, recipes/reports, security,
database errors and even custom messages. Quickly get your project finished using these
powerful tools.
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About the InduSoft Web Studio software components

The InduSoft Web Studio software suite comprises several individual components that can be installed on
different platforms to perform different functions. The architecture of your finished IWS project depends
on which components you install, where you install them, and how you connect them to each other.

The following table lists all of the available components.

Component

InduSoft Web Studio

Features

+  Project development environment

+  Tag integration

+  Remote management of project runtimes
+  Project runtime

+  Agent to allow remote management

* Project thin client

Platforms

*  Windows
+ Windows Server
*  Windows Embedded Standard

EmbeddedView (incl. Remote Agent)

+  Project runtime (limited tags and drivers)
+  Agent to allow remote management

+  Project thin client

Windows Embedded Standard

CEView (incl. Remote Agent)

+  Project runtime (limited tags and drivers)
+  Agent to allow remote management

+  Project thin client

Windows Embedded Compact

loTView (incl. Remote Agent)

+  Project runtime (limited tags and drivers)

+  Agent to allow remote management

platform-agnostic

Studio Database Gateway (StADOSvr)

Enables communication between the project
runtime and external databases, including
Historian and most ADO.NET-compatible
databases.

Should be installed separately when using
EmbeddedView or CEView, because most
ADO.NET data providers are not available on
Windows Embedded.

Must be installed separately when using loTView,
because Studio Database Gateway runs only on
Windows.

*  Windows

+ Windows Server

Web Tunneling Gateway (WTG)

Enables a public-facing web server to pass data
between the project runtime and thin clients, when
the project runtime is located on a secure, private
network.

Internet Information Services (IIS) for Windows

Mobile Access Runtime

Enables the project runtime to serve HTML5-
enhanced project screens to tablets and
smartphones.

+  Internet Information Services (IIS) for
Windows

+ any CGl-enabled web server (e.g., Apache)

Secure Viewer (a.k.a. InduSoft Thin Client)

Project thin client, as a standalone program.

+ Windows

+ Windows Server

*  Windows Embedded Standard
+ Windows Embedded Compact

Web Thin Client

Project thin client, as a browser add-on.

Internet Explorer for Windows

It is important to distinguish between the project development environment and the project runtime. The
project development environment enables you to design, develop, troubleshoot, deploy, and maintain

IWS projects. The project runtime actually runs your project, communicates with external databases and
devices, and serves project screens to thin clients.
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The full InduSoft Web Studio software includes both the project development environment and the project
runtime. Your software license determines which parts of the software you can use. For more information,
see Execution Modes on page 24.

In contrast, EmbeddedView and CEView are runtime-only components for Windows Embedded Standard
and Windows Embedded Compact, respectively, and IoTView is a new, platform-agnostic runtime for other
operating systems. They cannot be used for project development, so they have lower system requirements
than the full InduSoft Web Studio software.

In most cases, the first thing you should do is install the full InduSoft Web Studio software on your
primary workstation, because it not only sets up the project development environment for you, it also
unpacks the rest of the components so that they can be installed on other computers and devices.

g Tip: Separate installers for some components can be found on the InduSoft Web Studio
installation media or downloaded from our website (www.indusoft.com).

Differences between the runtime editions

You can develop projects once in the InduSoft Web Studio development environment and then run them
on any of the runtime editions. This section describes the differences between the editions, so that you
can decide which to use.

InduSoft Web Studio “full runtime”

&= Windows10 Myy S8 Windows Server2012
. Y .

BB Windows 8 yingews 7 & Windows Server 20082

Single, integrated
development
environment

InduSoft Web Studio

Development Station EmbeddedView

My Windows Embedded
A Standard 7

CEView

ml Windows Embedded
ME Compact

Develop once,
Deploy gpm—— li T loTView
anywhere - h Li
1mnux, 4
_—'A \A

Deploy a project to any runtime edition

The following table shows the basic system requirements for each runtime edition.

InduSoft Web Studio EmbeddedView CEView loTView
Windows 10 / Windows Supported Not supported Not supported Contact us 2
Server 2016

Windows 8 / Windows Supported Not supported Not supported Contact us 2
Server 2012

Windows 7 / Windows Supported Not supported Not supported Contact us 2
Server 2008

Windows 10 loT Enterprise | Supported Supported Not supported Contact us 2
Windows Embedded 8.1 Supported Supported Not supported Contact us 2
Industry Pro

Windows Embedded Supported Supported Not supported Contact us 2
Standard 7
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InduSoft Web Studio EmbeddedView CEView loTView
Windows Embedded Not supported Not supported Supported Contact us 2
Compact 2013

Windows Embedded Not supported Not supported Supported Contact us
Compact 7

Windows Eqnbedded Not supported Not supported Supported Contact us 2
Compact 6

Linux (Debian-based Not supported Not supported Not supported Supported
distributions)

Wind River VxWorks Not supported Not supported Not supported Supported
Available storage (hard 2GB 128 MB 64 MB 64 MB
drive or non-volatile)

Available memory (RAM) 1GB 64 MB 32MB 32MB

1. Windows Embedded Compact 6 was formerly known as Windows CE 6.

2. IoTView is a platform-agnostic runtime edition, which means it can run on many different devices
and operating systems. Only Linux and VxWorks are listed as "Supported" because those are the only
operating systems for which we have compiled and fully validated IoTView. If you want to run IoTView
on another device or operating system, contact your InduSoft Web Studio software distributor.

For a complete list of system requirements for each runtime edition, see the installation instructions for
that edition.

The following table shows the main differences in support for project features between the runtime
editions. (The majority of features are fully supported in all editions, so they are not listed.) If you develop
a project to include features that are not supported in your chosen edition, you might see unexpected
behavior and possibly even serious errors during run time. Some features will be automatically blocked in
the project development environment when you select your project's target platform, but you should still
be aware of the differences. For more information, see About target platforms, product types, and target

systems.
Y InduSoft Web Studio EmbeddedView CEView loTView
Run projects developed in Supported Supported Supported Supported
InduSoft Web Studio
Run as a Windows service Supported Not supported Not supported Not supported
Local project viewer Supported Supported Supported Not supported
Server for Secure Viewer Supported Supported Supported Not supported
Server for Web Thin Client | Supported Supported Supported Not supported
Support for Mobile Access | Supported Supported Not supported Supported
Support for Mobile Access | Supported Supported Supported Not supported
Tabular
Email (SMTP client) Supported Supported Supported with limitations ! Not supported
Create tags Supported Not supported Not supported Not supported
programmatically during
run time
Create screens Supported Not supported Not supported Not supported
programmatically during
run time
Save reports in PDF format | Supported Not supported Not supported Not supported
Built-in functions Supported Supported with limitations 2 Supported with limitations 2 Supported with limitations 2
Tag integration (a.k.a. Supported Supported Supported Not supported
Shared Tags)
Security Supported Supported Supported Supported with limitations s
Procedures Supported Supported Supported Not supported 4
Event Logger Supported Supported Supported Not supported
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T nduSoft Web Studio EmbeddedView CEView loTView

Translation Supported Supported Supported Not supported

Alarms Supported Supported Supported Supported with limitations s
Trends Supported Supported Supported Supported with limitations 6
Recipes Supported Supported Supported Not supported

Reports Supported Supported Supported Not supported

Math Supported Supported Supported Supported

Script Supported Supported Supported Not supported 4
Scheduler Supported Supported Supported Not supported
Database/ERP Supported Supported Supported Not supported

Drivers Supported Supported with limitations 7 Supported with limitations 7 Supported with limitations 7
OPC DA 2.05 Client Supported Supported with limitations 8 Supported with limitations 8 Not supported

OPC DA 2.05 Server Supported Supported with limitations 8 Supported with limitations 8 Not supported

OPC UA Client Supported Supported Supported with limitations ! Supported with limitations
OPC UA Server Supported Supported Not supported Supported

OPC XML/DA Client Supported Not supported Not supported Not supported

TCPIIP Client/Server Supported Supported Supported Not supported

OPC HDA Server Supported Not supported Not supported Not supported

Screens Supported Supported Supported Supported

Screen Group Supported Supported Supported Supported

Graphic Script Supported Supported Supported Not supported 4

Screen Script Supported Supported Supported Not supported 4

Shapes Supported Supported Supported Supported

Active Objects Supported Supported Supported Supported with limitations o
Data Objects Supported Supported Supported see Mobile Access
Libraries > Symbols Supported Supported with limitations 10 Supported with limitations 10 Supported with limitations 10
Libraries > ActiveX Supported Supported with limitations " Supported with limitations T Not supported

Controls

Libraries > .NET Controls Supported Not supported Not supported Not supported

Libraries > Linked Pictures | Supported Supported with limitations 12 Supported with limitations 121 see Mobile Access

Auto screen scaling Supported Not supported 13 Not supported 13 see Mobile Access

Fill effects in shapes Supported Supported with limitations B Supported with limitations ™| see Mobile Access

Ellipse object styles Supported Not supported 15 Not supported 15 see Mobile Access

Hint (tooltip) Supported Supported Supported with limitations 16 | see Mobile Access
Command events Supported Supported with limitations 17 Supported with limitations 7| see Mobile Access
Rotation animation Supported Supported with limitations 18 Supported with limitations 181 see Mobile Access

Trend Control > Fill effects | Supported Not supported Not supported see Mobile Access

Trend Control > Export to Supported Not supported Not supported see Mobile Access

File

Enhanced graphics (incl. Supported Not supported Not supported see Mobile Access
anti-aliasing)

Multi-touch gestures Supported Supported Supported with limitations 91 see Mobile Access

Number of project tags

150, 300, 1500, 4000, 16K,
32K, 64K, 512K, or 10M

150, 300, 1500, or 4000

150, 300, 1500, or 4000

150, 300, 1500, or 4000

Number of thin clients

Unlimited %°

Unlimited

Unlimited 2

Unlimited %
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T nduSoft Web Studio EmbeddedView CEView loTView
License Server Supported Not supported Not supported Not supported
Hardkey license (USB) Supported Supported with limitations A Supported with limitations 21 Not supported

1. Encryption (TLS/SSL) is not supported in CEView.

N

Most of the functions are supported in all editions, but some specific functions are not supported in
EmbeddedView/CEView or loTView. For more information, see List of available functions.

Local mode only. Distributed and Domain modes are not supported in IoTView.
VBScript is not supported in IoTView.
Online alarms only. Alarm history is not supported in IoTView.

Database format only. Proprietary format is not supported in loTView.

No g s e

Most of the drivers are supported in all editions, but some specific drivers are not supported in
EmbeddedView/CEView or IoTView. For more information, see the documentation for each driver,
which can be accessed through the project development environment: on the Help tab of the ribbon, in
the Documentation group, click Communication Drivers.

8. Single-thread only; multi-thread is not supported.
9. Pushbutton, ListBox, and Smart Message objects are not supported. Minor limitations in other objects.

10.A specific linked symbol is supported as long as all of its component objects and animations are also
supported.

11.A specific ActiveX object is supported as long as it is compiled for the target platform.

12.BMP, JPG, and PNG images are supported, as long as the operating system image on the Windows
Embedded device also supports them. For more information, see "Why are my linked pictures no longer
displayed on Windows Embedded devices?" in the FAQ.

13.Use the Convert Resolution command to scale your project screens for other display sizes. For more
information, see Convert your project's display resolution.

14.Rectangle objects only.

15.Default style only. Other styles (e.g., Arc, Chord, Ring) are not supported. For more information, see
Ellipse object.

16.The system tag Hint will be updated, but the actual tooltip will not be displayed on screen in CEView.
For more information, see Object Properties dialog box.

17.0n Down, While Down, and On Up events only. For more information, see Command animation.
18.Closed Polygon objects only.

19.Zooming in screens, panning in screens, and rotating objects are not supported in CEView. For more
information, see About the different types of multi-touch gestures.

20.Limited by license and external and physical constraints (hardware and operating system).

21.Hardkeys provided by Wibu-Systems are supported. Hardkeys provided by Sentinel (SafeNet) are not
supported. For more information, see About hardkey licenses.

g Note: For a comprehensive list of supported features and limitations in IoTView, see List of
features supported in projects running on IoTView.
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Install the full InduSoft Web Studio software

Install the full InduSoft Web Studio software on your Windows computer in order to develop IWS projects,
or to use the computer as a project runtime server and/or thin client.

To install and run the full InduSoft Web Studio software, you must have the following:

* A Windows-compatible computer with a standard keyboard, a pointer input (i.e., a mouse, trackpad, or
touchscreen), and an SVGA-minimum display;

¢ One of the following Windows operating systems:
* Windows Server 2016
* Windows Server 2012 R2
*  Windows Server 2008 R2 Service Pack 1
e Windows 10 (including LTSC/LTSB versions)
* Windows 8.1
* Windows 7 Service Pack 1
¢ Windows 10 IoT Enterprise (LTSC/LTSB version only)
¢ Windows Embedded 8.1 Industry Pro (formerly known as Windows Embedded Standard 8)
* Windows Embedded Standard 7 Service Pack 1
e .NET Framework 3.5 and .NET Framework 4.7 (see note below);
¢ Internet Explorer 11 or later (not Microsoft Edge);
* 2 GB free storage (hard drive or non-volatile);
* 1 GB free memory (RAM); and
¢ An Ethernet or Wi-Fi network adapter.

We recommend the "Pro" and "Enterprise" editions of Windows, because they include Internet Information
Services (IIS) as a pre-installed feature that can be turned on. You can use IIS to make your projects
accessible to thin clients and mobile devices. We do not recommend the "Home" and "Education” editions
of Windows, because they hide or disable many important features.

Only Windows 10 and Windows Server 2016 are under what Microsoft calls "mainstream support",
which means they are actively maintained and additional service packs might be released for them in
the future. Windows 8.1, Windows 7, Windows Server 2012 R2, and Windows Server 2008 R2 are under
what Microsoft calls "extended support”, which means they are no longer actively maintained. For more
information, go to: support.microsoft.com/en-us/help/13853 /windows-lifecycle-fact-sheet

You can install the full InduSoft Web Studio software on a Windows IoT or Windows Embedded device,
as long as it meets the system requirements listed above, but if you do not plan to develop projects on
that device then you should install EmbeddedView instead. For more information, see Install the project
runtime software on a Windows Embedded device on page 20.

Regardless of which version or edition of Windows you are using, you should make sure it is fully updated
before you install InduSoft Web Studio. Updating Windows ensures that it has all of the latest security
fixes and system components.

- Note:

You must have both .NET Framework 3.5 and .NET Framework 4.7 installed and turned on in
order to use all of the features of InduSoft Web Studio.

If Windows is fully updated, as described above, then the latest versions of .NET Framework
should be installed. They might not be turned on, however, so use the Windows Features control
panel to confirm that they are.

In some cases, it might not be possible to keep Windows fully updated through normal means.
(For example, if your computer is on a secure network, then it might not be able to contact

the Windows Update service.) The InduSoft Web Studio software installer will check for both
versions of .NET Framework, and if it does not find them, it will attempt to install them for you.
Depending on your computer's security settings, however, the installation(s) might fail without
notice. Therefore, if you experience issues later while trying to use InduSoft Web Studio — in
particular, while trying to communicate with external databases — use the Windows Features
control panel to confirm that both versions of .NET Framework are installed and turned on.
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In Windows Server 2012 R2, .NET Framework 3.5 is not pre-installed and it cannot be installed
by the InduSoft Web Studio software installer. You must use the Server Manager tool to install it.
For more information, see Install .NET Framework 3.5 in Windows Server 2012 R2.

For more information about .NET Framework, go to: docs.microsoft.com/en-us/dotnet/
framework/index

The following items are optional but recommended:
e A USB port, to install the software from a USB flash drive.
This is optional because you can also download the installer over the network to your computer.
e A USB port or memory card slot, to be used for hardkey licensing of the software.
This is optional because softkey licensing is also available.
¢ Serial COM ports and adapters, to be used for direct communication with PLCs and other devices.

This is optional because many newer device protocols use TCP/IP or UDP/IP communication (i.e.,
Ethernet) instead of serial communication.

¢ Internet Information Services (IIS) installed and turned on; for more information, see the description of
the Mobile Access Runtime option below.

This is optional because you may choose not to install the Mobile Access Runtime feature at this time,
as part of the full InduSoft Web Studio software. You can install it at a later time, for either IIS or CGI.

e Visual Studio 2010 or Team Explorer 2010 installed on the same computer; for more information, see
the description of the Collaboration option below.

This is optional because you may choose not to install the Collaboration feature.
Finally, you must have Administrator privileges on the computer in order to install any software.
To install the full InduSoft Web Studio software:

1. Close all other running programs, if possible.

We recommend you do this because those programs can use a significant amount of system resources
and therefore cause this installation to take longer to finish. Windows services (e.g., Windows
Defender, Windows Update) can have the same effect, but we do not recommend you stop or disable
those services.

2. Do one of the following:

¢ Download the zipped installer to your computer, either from our website (www.indusoft.com) or
from another location on your network where you have previously saved it. Extract the files, open
the resulting folder, and then locate and run the setup program (setup.exe).

¢ Insert the installation drive into your USB port. If it does not autorun, locate and open the Welcome
page (InduSoft.htm). When the page is opened in your browser, click Product Installation and then
follow the instructions.

The installation wizard runs and asks you to select a language for the installation.

3. Select a language from the list, and then click OK.

This selection determines the language of the user interface for both the installation wizard and
the project development environment. You can change the language for the project development
environment later, after the software has been installed.

The wizard prepares for installation. During this step, it automatically installs SafeNet's Sentinel
drivers (a part of the software licensing mechanism), .NET Framework 3.5, and .NET Framework 4.7, if
necessary.

4. On the Welcome page of the wizard, click Next to proceed with the installation.

5. On the License Agreement page, click Yes to accept the agreement and proceed, or click No to refuse the
agreement and exit the wizard.

6. On the Customer Information page, type your user name and company name, and then click Next.

7. On the Choose Destination Location page, select the folder where the software should be installed, and then
click Next.

By default, the software will be installed at the following location:

C:\Program Files (x86)\InduSoft Web Studio v8.1\
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8. On the Select Features page, select the specific features and components that you want to install, and

then click Next.
Feature

Program Files

Demos
Hardkey Support

OPC Components

PDF Printing

Security System Device Driver

Symbol Library

Runtime for Windows Embedded Compact

Runtime for Windows Embedded Standard

Mobile Access Runtime

Description

The main program files for the project
development application, the project runtime
server, and the project runtime client. This
feature cannot be deselected.

Premade projects that demonstrate the
capabilities of the InduSoft Web Studio software.

Additional drivers to support the use of hardkey
licenses.

Additional components required for
communication with other OPC-compatible
devices. This includes OPC DA (a.k.a. OPC
Classic), OPC XML-DA, and OPC UA.

Additional software that allows run-time reports
to be saved as PDF files.

An additional keyboard driver that enforces
project security during run time by controlling
user input.

A library of premade but configurable screen
objects such as pushbuttons, toggle switches,
gauges, dials, indicator lights, and so on.

Also called CEView, the project runtime software
(server/client, but not development) for Windows
Embedded Compact on selected processors.
Check the documentation for your specific device
to see which processor it uses.

Selecting this feature will not actually install
CEView on your computer at this time. It will
simply unpack the installation files and copy
them to your program folder, so that you can
install CEView on a Windows Embedded Compact
device at a later time.

Also called EmbeddedView, the project runtime
software (server/client, but not development) for
Windows Embedded Standard computers.

Selecting this feature will not actually install
EmbeddedView on your computer at this time.

It will simply unpack the installation files and
copy them to your program folder, so that you can
install EmbeddedView on a Windows Embedded
Standard computer at a later time.

Add-on software for web servers that allows
mobile devices (i.e., smartphones and tablets) to
access your projects. This software is available for
both Internet Information Services (IIS) and other,
CGI-based web servers like Apache.

You do not need to install this feature

at this time. Regardless of whether you

select this installation option, a separate

Mobile Access Runtime software installer
(MobileAccessSetup.exe) will be unpacked with
the rest of the InduSoft Web Studio software, and
you can choose to run that installer at a later
time.

To use this feature, your software license must
include the Mobile Access Runtime add-on. To
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Feature

Collaboration Tools

loTView

Historian

Custom Widget Framework

OPC Factory Server

Description

purchase this add-on, contact your InduSoft Web
Studio software distributor.

Additional tools for workgroup collaboration and
source control within the InduSoft Web Studio
project development environment.

This feature requires that you have Visual Studio
Team Explorer 2010 installed on the same
computer. The InduSoft Web Studio software
installer will attempt to verify that you do, and

if you do not, it will not install this feature.

To download Team Explorer 2010 for free,

go to: www.microsoft.com/en-us/download/
details.aspx?id=329

The full version of Visual Studio 2010 includes
the Team Explorer module.

¢ Note: Team Explorer 2012, Team
Explorer 2013, and Team Explorer
2017 are not supported as collaboration
clients at this time.

You should also have Visual Studio Team
Foundation Server 2010 or 2012 running
somewhere on your network, but if you do
not, it will not prevent you from installing the
Collaboration feature at this time.

g Note: Team Foundation Server 2013
and Team Foundation Server 2017 are
not supported as collaboration servers
at this time.

To use this feature, your software license must
include the Collaboration add-on. To purchase
this add-on, contact your InduSoft Web Studio
software distributor.

The project runtime software for Linux and
VxWorks.

Selecting this feature will not actually install
IoTView on your computer at this time. It will
simply unpack the installation files and copy
them to your program folder, so that you can
install IoTView on another computer at a later
time.

Additional software that is required to save
historical data (e.g., from Trend worksheets) to
Historian databases and AVEVA Insight.

This feature requires that you have .NET
Framework 4.7.2 installed and turned on.

Additional software that is required to develop
HTMLS-based widgets and then use them in
project screens.

A standalone OPC server that your projects can
use to communicate with Schneider Electric PLCs
(e.g., M340, M580, Quantum, TSX Compact,

TSX Micro, TSX Momentum, TSX Series 7, TSX
S1000, TSX/PCX Premium, Unity Momentum).
For more information, see the documentation that
is installed with OPC Factory Server.
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9. On the Ready To Install page, click Install.

g Note: You might receive the following error message during installation: "Error 1628: Failed
to complete script based install." For more information about this error and how to resolve it,
go to: flexeracommunity.force.com/customer/articles/en_US/ERRDOC/Error-1628-Failed-
To-Complete-Script-Based-Install

g Note: If you try to install an earlier version of the InduSoft Web Studio software on a
computer that already has a later version installed, you might receive the following message
during installation: "Version x.x.x.x of CodeMeter Development Kit is already installed.
Downgrading to Version x.X.X.x is not possible, installation will be aborted." CodeMeter is
supplemental software used by InduSoft Web Studio to manage hardkey licenses. To resolve
this issue, you must use Task Manager in Windows to stop CodeMeter Runtime Server
(CodeMeter.exe) before you install the earlier version of InduSoft Web Studio.

The software is installed, and then when the installation is finished, the last page of the wizard is
displayed.

10.Click Finish to close the installation wizard.

When you have finished the installation, you can find the software in your Windows Start menu at: Start >
InduSoft Web Studio v8.1

g Note:

In Windows 8 / Windows Server 2012, the software should be located at: Start > Apps > InduSoft
Web Studio v8.1

In Windows 7 / Windows Server 2008, the software should be located at: Start > All Programs >
InduSoft Web Studio v8.1

The software includes the following "apps" (applications):

IWS v8.1 InduSoft Web Studio

The project development environment, project runtime server, and project thin client. Its
capabilities are determined by your software license.

IWS v8.1 Help Manual
A complete technical reference and user guide for all of the InduSoft Web Studio software.
IWS v8.1 Quick Start Guide

A brief guide to installing and using the project development environment, including a
tutorial for developing a simple project.

IWS v8.1 Register

A utility program that manages your InduSoft Web Studio software license.
IWS v8.1 Release Notes

A list of changes in the InduSoft Web Studio software.
IWS v8.1 Remote Agent

A utility program that allows InduSoft Web Studio running on other computers to connect to
your computer and send projects to it.

IWS v8.1 StartUp
A shortcut that automatically starts the project runtime and runs the most recent project.
There should also be a shortcut icon on your desktop.
To run the software, do one of the following:
¢ Double-click the shortcut icon on your desktop; or
e Click Start > InduSoft Web Studio v8.1 > IWS v8.1 InduSoft Web Studio.

If the installation failed for any reason, you can use System Restore to restore the computer to the restore
point that was created at the beginning of the installation. For more information about System Restore, go
to: support.microsoft.com/help/ 17127 /windows-back-up-restore
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Install the project runtime software on a Windows Embedded device

Install EmbeddedView on a Windows Embedded Standard computer, or install CEView on a Windows
Embedded Compact device, in order to use it as a project runtime server and/or project thin client.

If EmbeddedView or CEView is preinstalled on the target device, you may skip this entire task. Many
manufacturers preinstall the project runtime software on their devices, as part of a larger InduSoft Web
Studio package.

Before you begin this task, you must have already installed the full InduSoft Web Studio software on your
computer, either from the installation disc or from the downloadable installer, because the redistributable
EmbeddedView and CEView software is included in the InduSoft Web Studio program folder. For more
information, see Install the full InduSoft Web Studio software on page 15.

To install and run EmbeddedView or CEView, you must have:
* A Windows Embedded-compatible device (hereafter called "the target device");

¢ A Windows Embedded operating system that is currently supported by Microsoft, which at this time
includes:

e Windows 10 IoT Enterprise (LTSC/LTSB version only)

* Windows Embedded 8.1 Industry Pro (formerly known as Windows Embedded Standard 8)
* Windows Embedded Standard 7 Service Pack 1

* Windows Embedded Compact 2013

¢ Windows Embedded Compact 7

* Windows Embedded Compact 6 (formerly known as Windows CE 6)

e 128 MB of free storage (hard drive or non-volatile) for the runtime. More storage might be required
depending on your project size.

¢ 64 MB of free memory (RAM). More memory might be required depending on your project size.

* An Ethernet or Wi-Fi network adapter.

The following items are optional but recommended:

e A USB port; and

¢ Serial COM ports and adapters, to be used for direct communication with PLCs and other devices.

This is optional because many newer device protocols use Ethernet communication instead of serial
communication.

Installing EmbeddedView or CEView on a target device is actually a two-part procedure. First, you will
copy the Remote Agent utility to the target device and then run it. Remote Agent allows you to connect
from the project development environment to the target device. And then, through this connection, you
will install the rest of the EmbeddedView or CEView software.

To install EmbeddedView or CEView:

1. Turn on the target device, and then make sure your development workstation can connect to the device
using either serial or Ethernet communication.
You will be asked to specify the connection type in later steps.
If Remote Agent is preinstalled on the target device, it will run automatically on startup and you may
skip the next step. Many manufacturers preinstall Remote Agent on their devices, as part of a larger
InduSoft Web Studio package.

2. Copy the Remote Agent utility to the target device, and then run it:
a) Locate the correct version of the Remote Agent utility (CEServer.exe) for the target device. All

versions are stored in your InduSoft Web Studio program folder.

Remote Agent for Windows Embedded Standard is located at:

C:\Program Files (x86)\InduSoft Web Studio v8.1\Redist\WinEmbedded\Bin
\CEServer.exe
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b)

d)

Remote Agent for Windows Embedded Compact is located at:

C:\Program Files (x86)\InduSoft Web Studio v8.1\Redist\WinCE 5.0\processor\Bin
\CEServer.exe

...where processor is the specific processor used by the target device. For more information, consult
the manufacturer's documentation.

Copy CEServer.exe to the target device by either downloading it over the network, transferring

it on a USB flash drive, or syncing it with Microsoft ActiveSync. (ActiveSync is also known as
Windows Mobile Device Center in Windows Vista or Zune Software in Windows 7.) You may save
the file anywhere you want on the target device, as long as it is in permanent (i.e., non-volatile)
memory and it is not in the root folder (i.e., C:\ on Windows Embedded Standard, or \ on Windows
Embedded Compact).

Set Remote Agent to run automatically on startup.

You can do this on most Windows Embedded Compact devices by creating a shortcut to
it in \Windows\Startup. If this does not work on your device, consult the manufacturer's
documentation.

Run Remote Agent, or restart the device so that it runs automatically.

The Remote Agent window is displayed.

L K Remote Agent (v7.12)

Connection status:
Mot connected to remote clisnt

Log:

Device connection via Network |
(TCPAIP) S

Setup Exit

IP[s): 192.168.150.32, 10.211.55.3

3. Configure the communication settings in Remote Agent:

a)

b)

c)
d)

Click Setup.
The Setup dialog box is displayed.

LR Setup

Device Connection

() Serial Port COm1
(® TCP/P
Infra Red
Data Protection 0K
Users... Cancel

Select the appropriate connection type: Serial Port or TCP/IP. If you select Serial Port, also select the
COM port and review the advanced settings.

If you are already connected to the target device via ActiveSync, you do not need to select another
connection at this time. However, keep in mind how the target device will actually be used during
project run time.

Click OK.
If you selected TCP/IP for the connection type, note the device's IP address.

Make sure that you leave Remote Agent running on the target device.
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4. Use the Remote Management tool to connect to the target device:
a) Run the project development application on your computer.

b) On the Home tab of the ribbon, in the Remote Management group, click Connect.

The Remote Management dialog box is displayed.

Remote Management
Target ~il Specify and connect to the target host before you can download your project and
ul the run-time
Project h
Impart Target Station Disconnect

Embedded License (®) Host: 0.0.0.0 Status:

Serial Port: Advanced Platform:

() Microsoft ActiveSync

nstall system files... | [ only newer files

oK Cancel

c) Select the appropriate connection type for the target device: Host, Serial Port, or Microsoft ActiveSync. If
you select Host, also type the host name or IP address of the target device. If you select Serial Port,
also select the COM port and verify the advanced serial communication settings.

d) Click Connect.

If you are successfully connected to the target device, the connection status is shown in the Status
box and the device's specifications are shown in the Platform box.

If you are not connected, check both the connection settings and the physical connections. In
particular, if you have selected Host as the connection type, check to make sure that port 4322 is
open on any firewalls between your computer and the target station, including on the target station
itself.

- Note:

In some cases, the Remote Management tool may not be able to connect via Microsoft
ActiveSync to a device running Windows CE 6.0 or later. This is because of a problem in
the default configuration of Windows CE 6.0. You can fix the problem by using a small
utility that is included with InduSoft Web Studio. The utility is located at:

C:\Program Files (x86)\InduSoft Web Studio v8.1\Redist
\ActiveSyncUnlock.exe

Copy this file to the device using the stand-alone version of Microsoft ActiveSync and then
execute the file on the device. It does not matter where the file is located on the device.
When this is done, try again to use the Remote Management tool to connect to the device.

If you still cannot connect via Microsoft ActiveSync, empty the device's \Temp directory
and try again.

S. Install the rest of the EmbeddedView or CEView software on the target device:
a) In Remote Management, click Install system files.

When the installation is finished, the target device's updated status is displayed in the Status box.

With EmbeddedView or CEView installed on the target device, you can now use it as a project runtime
and/or thin client.

Keep in mind that some run-time features are supported by InduSoft Web Studio (with a Runtime license)
but not by EmbeddedView and CEView. If you develop a project that uses any of these features and then
try to run it in EmbeddedView or CEView, you might see unexpected behavior and possibly even serious
errors during run time. Some features will be automatically blocked when you change your project's target
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platform, but you should still be aware of the differences between runtime editions. For more information,
see About the InduSoft Web Studio software components on page 10.
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Execution Modes

InduSoft Web Studio, EmbeddedView, and CEView support the following execution modes:

Execution Mode InduSoft Web Studio EmbeddedView / CEView
Evaluation Mode Supported Not supported

Demo Mode Supported Supported

Licensed for Engineering Only Supported Not supported

Licensed for Runtime Only Supported Supported

Licensed for Engineering + Runtime Supported Not supported

Evaluation Mode
Enables all of the product's engineering and runtime features.

The first time you install InduSoft Web Studio on a computer, the product runs for forty
(40) hours in Evaluation Mode. This evaluation period includes any time you run a product
module (engineering or runtime). You can use this evaluation period continuously or not;
for example, 10 hours a day for 4 days, or 5 hours a day for 8 days, or 10 hours a day for 3
days plus 5 hours a day for 2 days, and so on.

After running for 40 hours in the Evaluation Mode, the evaluation period ends and the
program automatically converts to Demo Mode until you apply a valid license. You cannot
reactivate Evaluation Mode, even if you reinstall the software on your computer.

g Note: Each version of InduSoft Web Studio has an evaluation period that
is independent of every other version. For example, if an earlier version is
running in Demo Mode because its evaluation period has expired, and then
you install the latest version on the same computer, the latest version will
begin its own 40-hour evaluation period and the earlier version will continue
to run in Demo Mode.

Demo Mode

Allows you to download projects to remote stations and to run projects for testing or
demonstration purposes. You can execute runtime tasks and use the debugging tools
(LogWin and Database Spy), but they shut down automatically after running for two hours
continuously. You can restart the Demo Mode again and run for another two hours, and so
on.

You cannot create or modify screens, worksheets, or project settings in Demo Mode.

Licensed for Engineering Only
Enables all development options for an unlimited time.
This mode also allows you to continuously run the runtime tasks and debugging tools
(Database Spy, Output window, and LogWin module) for 72 hours. After that period, these
tasks shut down, but you can restart them and run for another 72 hours, and so on. You
can use this license for development and testing only.

Licensed for Runtime Only
Enables all runtime tasks and debugging tools (Database Spy, Output window, and LogWin
module) for unlimited time, but you cannot create or modify screens and/or worksheets.

The menu options available in Runtime Only mode are the same as the options listed for
Demo Mode (see previous table).
Licensed for Engineering + Runtime

Enables all development options, runtime tasks, and debugging tools (Database Spy, Output
window, and LogWin module) for an unlimited time.

¢ Note: The Remote Management tool is always available, regardless of the execution mode, so
that you can upload files from or download files to remote stations.

To see which execution mode you are currently running, click About on the Help tab of the ribbon; the
About dialog shows the execution mode, including the time remaining if you are in Evaluation Mode.
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The Development Environment

InduSoft Web Studio incorporates a modern, Ribbon-based Windows interface to provide an integrated

and user-friendly development environment.
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Title Bar

The Title Bar located along the top of the development environment displays the application name (e.g.,
InduSoft Web Studio) followed by the name of the active screen or worksheet (if any).

Application - SCRIPT0001 [Language: VBScript] - B X

Example of Title Bar

The Title Bar also provides the following buttons (from left to right):

Minimize button : Click to minimize the development environment window to the Taskbar.

Restore Down / Maximize: Click to toggle the development environment window between two sizes:

Restore Down button reduces the window to its original (default) size.

Maximize button enlarges the window to fill your computer screen.

Close button -: Click to save the database and then close the development environment. If you
modified any screens or worksheets, the application prompts you to save your work. This button's
function is similar to clicking Exit Application on the Application menu.

g Note: Closing the development environment does not close either the project viewer or the
runtime system, if they are running.
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Status Bar

The Status Bar located along the bottom of the development environment provides information about the
active screen (if any) and the state of the application.

Engineering + Runtime| CAP, NUM| SCRL|ID: 0 X: 160,Y: 90 W: 201, H: 181 Tag count: 0

Example of Status Bar

The Status Bar fields (from left to right) are described in the following table:

Field Description

Execution Mode The current execution mode of the application.

CAP Indicates whether the keyboard Caps Lock is on (black) or off (grey).

NUM Indicates whether the keyboard Num Lock is on (black) or off (grey).

SCRL Indicates whether the keyboard Scroll Lock is on (black) or off (grey).
Object ID The ID number of a selected screen object.

Cursor Position The location of the cursor on the active screen or worksheet. If it's a screen,

then the position of the mouse cursor is given as X,Y coordinates, where X is
the number of pixels from the left edge of the screen and Y is the number of
pixels from the top edge of the screen. If it's a worksheet, then the position of
the text cursor is given as Line and Column.

Object Size The size (in pixels) of a selected screen object, where W is the width and H is
the height.
No DRAG Indicates whether dragging is disabled (No DRAG) or enabled (empty) in the

active screen.

Tag Count The total number of tags used so far in the project.
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Application button
The Application button opens a menu of standard Windows application commands like New, Open, Save,
Print, and Close.

sh. VAPPLVAPPLAPP

-.\Sample\Sample. APP

.
_] New Recent Projects
- +

4 C\Users\...\Sample\Sample.APP

g o= >
'
Print v
-
Clase " [\}

Project Settings || 2 Exit Application

Application button opens menu of commands
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Quick Access Toolbar

The Quick Access Toolbar is a customizable toolbar that contains a set of commands that are independent
of the ribbon tab that is currently displayed.

Move the Quick Access Toolbar

The Quick Access Toolbar can be located in one of two places:

e Upper-left corner next to the Application button (default location); or

¢ Below the ribbon, where it can run the full length of the application window.

If you don't want the Quick Access Toolbar to be displayed in its current location, you can move it to the
other location:

" Click Customize Quick Access Toolbar 7.
2. In the list, click Show Below Ribbon or Show Above Ribbon.

Add a command to the Quick Access Toolbar

You can add a command to the Quick Access Toolbar directly from commands that are displayed on the
ribbon:

1. On the ribbon, click the appropriate tab or group to display the command that you want to add to the
Quick Access Toolbar.

2. Right-click the command, and then click Add to Quick Access Toolbar on the shortcut menu.

You can also add and remove commands — as well as reset the toolbar to its default — using the
Customize dialog:

" Click Customize Quick Access Toolbar 7.
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2. In the list, click More Commands. The Customize dialog is displayed.

Customize

Customize

Commands:

Choose commands from:

<Separators

4 Close
4 Close
Cloze all
X Exit
1 Mew
|__F: Open Project
|_,.-—q' Open Project
[ = Open Project File
i Print
i Print
L} Print Preview
G Print Setup
Project Settings
N

Kevboard shortcuts:

[] Show Guick Access Toolbar below the Ribbon

Add =

Remove

1 New

|__F: Open Project

By Save Al
[ Close

ﬁ Run
@ Stop

a Cortext Sensitive

Reset

Cancel

Customize Quick Access Toolbar dialog

3. In the Choose commands from menu, select the appropriate Ribbon tab. The commands from that tab are

displayed in the Commands list.

4. In the Commands list, select the command that you want to add to the Quick Access Toolbar.

5. Click Add.

Only commands can be added to the Quick Access Toolbar. The contents of most lists, such as indent
and spacing values and individual styles, which also appear on the ribbon, cannot be added to the Quick

Access Toolbar.
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Ribbon

The new ribbon combines the numerous menus and toolbars from the previous versions of this software
into a single, user-friendly interface. Almost all application commands are now on the ribbon, organized
into tabs and groups according to general usage.

Home tab

The Home tab of the ribbon is used to manage your project within the development environment.

|
—"‘j Home View Insert Project Help

== ¥ cut =| 3 Run ’ ) Download [= i ﬂ

‘j 53 Copy = |ﬁ Stop i3 Fun

Paste Tasks g Connect Tasks Database LogWin
&% Find/Replace oDEbug > LB Stop Spy

Clipboard Local Management M Eemote Management ]

S L e T

— %almpnrtWizard / 3 Replace d’@' J
» | 1
Cf= Convert Resolution ﬁiRemnue unused tags ﬁt:rnss Reference |

Werify Global
¢%| Register Controls Replace 58 Reset tags database ﬁF‘mperties ‘g
[ Tools ] Tags 1
L]

Home tab of the ribbon

The tools are organized into the following groups:
* Clipboard: Cut, copy, paste, and find items in project screens and task worksheets.

* Local Management: Run and stop the project on the local station (i.e., where the development application
is installed), as well as manage the execution tasks. You can also run a project in Debug mode, for
debugging VBScript.

* Remote Management: Connect to a remote station so that you can download the project to it, and then
run, stop, and troubleshoot the project on that station. For more information, see About remote
management.

¢ Tools: Miscellaneous tools to verify the project, import tags from other projects, convert screen
resolutions, and register ActiveX and .NET controls.

e Tags: Manipulate tags and tag properties in the project database.

View tab

The View tab of the ribbon is used to customize the look of the development environment itself.

|
—"’f Home View Insert Project Help

| Project Explorer % Grid Line Number || Zoom |1000: = _,,;;.._
E M ™ ‘eﬁ

W Database Spy | Sstatus Bar
Restare Fitto Zoom
Default ¥ OCutput Window Zoom Box Window  Area

A it I

Show/Hide Zoom
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= 3
¥ Language = ;
Ag Font ] ]
Windows... | |
¥ Buto Size Row = 1
Options Window 1

View tab of the ribbon

The tools are organized into the following groups:

¢ Show/Hide: Show and hide the different parts of the development environment, as well as restore the
default layout.

e Zoom: Zoom in and out of the screen editor.
e Options: Change the language and font used in the development environment.

e  Window: Arrange the windows in the development environment.

Insert tab

The Insert tab of the ribbon is used to insert new tags, screens, worksheets, and other components into
your project.

A

Home View Insert Project Help

. 1

| i =l 3
ﬂ ; P Translation Screen 4
-d

A = Procedures File | I Sereen Group g

Tag Class ’

Global Graphics 1
p i
A 2larm T Report {5 Scheduler | %M OPC Client ~ ] Driver Sheet 1
A Trend = script [ Database - | a1 TCP/P Client W ain Driver sheet 14
Recipe %Math !;Add_a‘RemnvE Drriver 11
Task Worksheets Communication 4

L

Insert tab of the ribbon

The tools are organized into the following groups:

* Global: Insert tags, classes, translations, and procedures into the Global tab of the Project Explorer.
* Graphics: Insert screens and screen groups into the Graphics tab of the Project Explorer.

* Task Worksheets: Insert task worksheets into the Tasks tab of the Project Explorer.

e Communication: Insert server configurations and communication worksheets into the Comm tab of the
Project Explorer.
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Project tab

The Project tab of the ribbon is used to configure your project settings.

|
— Home

LY B =)

Target System
[Local Interface] =

View Insert

Project

Help

Em = - ﬁ
IEI? LEE] = B

Information Cptions Communication Viewer Preferences E-Mail/FTP Service

settings F]

AR I g e PR

. iy
Zos 2

Configure Log  Access
On level
u Security System

Web Mobile Mobile Access
Access Tabular

Web

| 4
o B %
!

Project tab of the ribbon

The tools are organized into the following groups:

» Settings: Configure the general project settings, set the project to run as a Windows service, or enable

workgroup collaboration and version control.

* Security System: Enable and configure the project security system.

* Web: Configure the project to accept connections from a variety of thin clients.

Graphics tab

The Graphics tab of the ribbon is used to draw project screens.

— Home View Insert Project Graphics Format He.
mE:l] +=® | Background Image L Selection = @F‘rnperties =
= -
= —8 0y Background Color = r':, Disable Drag ﬁ Grid Settings - D
Attributes Script Arrange
@Laynut 3.c Replace 5 Undo =
-
SCreen Editing li
/" Line [ ] Rectangle A Ted @ Pushbutton  EfF Combo Box
L Open Polygon (] Rounded Rectangle || L}l Text Box Check Box  [Bff List Box
|| 4 Closed Polygon () Ellipse [ Button @ Radio Button [ Smart Message

Shapes

Active Objects

g W S U
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A

J Alarm/Event m Bex activeX Control = | (¥ Command ab| Text Data Link Resize J
74 Trend ™ Linked Picture L Hyperlink a Color ) Rotation |4
Symbaols ]

i Grid B customwidget || il Bargraph B visibility/Position :
Data Objects Libraries Animations 1

Graphics tab of the ribbon

g Note: This tab is available only when you have a project screen open for editing.

The tools are organized into the following groups:

* Screen: Configure settings for the project screen itself, such as its attributes, script, and background
color or image.

* Editing: Select and edit objects in the project screen.

¢ Shapes: Draw static lines and shapes.

* Active Objects: Draw active objects, like buttons and check boxes.

* Data Objects: Draw objects that display historical data, like alarms, events, and trends.

e Libraries: Select from libraries of premade objects, such as symbols, ActiveX and .NET controls , external
image files, and HTML5-based custom widgets.

* Animations: Apply animations to other screen objects.

Format tab

The Format tab of the ribbon is used to format and arrange objects in a project screen.

-
- Home View Insert Project Graphics Format Help

4

™M o ' = ¥ x 100 AT 1 S2width: 320
3 B A +

4k
4k

Ak
T 'I—ﬁ- o e ok, e

7 . 100 4| %o+ O[] Height: | 240
Bring to Send to Group Align Rotate Resize
front~ back~ - - - -
Arrange Position Size \
|
N 1
* - 1
k Arial - [11 - 4
)| = 1
A A|/B 7 U abe A~
Style Fonts ] J

Format tab of the ribbon

g Note: This tab is available only when you've selected one or more objects in a project screen.

The tools are organized into the following groups:

* Arrange: Arrange objects in a project screen, including bring to front and send to back, group, align, and
rotate.

* Position: Precisely adjust the position of a screen object in a project screen.

* Size: Precisely adjust the size of a screen object.
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* Style: Change the fill and line color of a screen object.

* Fonts: Change the caption font of a screen object.

Help tab
The Help tab of the ribbon provides additional help with using the software.

— Home View Insert Project Graphics Format Help
ﬂ ¥ /" F s e ']
A ) J
Od  / @ JdbDO

Context Help Communication License  Product Release Support About

Sensitive Drrivers Agreement Web Site Motes
Documentation Information
Help tab of the ribbon

The tools are organized into the following groups:

¢ Documentation: Access the documentation for the development application, including this help file /
technical reference and notes for the individual communication drivers.

* Information: Access other information about InduSoft Web Studio, including the license agreement,
product website, and release notes, as well as system and support details that make it easier for
Customer Support to assist you.
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Project Explorer

The Project Explorer organizes all of the screens, worksheets, and other items that comprise your project
and presents them in an expandable tree-view.

To open a folder and view its contents, either click the Expand icon » to the left of the folder or double-
click the folder itself.

To close a folder, click the Collapse icon 4 to the left of the folder.

If you right-click any item in the Project Explorer, then a shortcut menu will appear with contextual
commands for that item.

There are four main sections, or tabs, in the Project Explorer: Global, Graphics, Tasks, and Comm.

Global tab

The Global tab of the Project Explorer contains the project tags database, as well as other features that
apply to the entire project such as the security system, VBScript procedures, and Ul translation.

Project Explorer o X

v % Project: Project.APP
V- |, Project Tags

----- [[] Datasheet View

..... |, Tag List (0}

..... Classes

w .| Shared database

----- [[] Datasheet View

..... |, Tag List (0}

w -, System Tags

..... ﬂ:] Datasheet View

- |, Tag List (48]

W |, Security

- Groups
Users

w - | Procedures
-...=] Main Procedures
..... = Event Logger

----- ¥4 Translation

@ Global| M Graphics {#Tasks 73l Comm
Global tab of the Project Explorer

The folders on the Global tab are described in the following sections:

Project Tags
The project tags database contains all of the data tags that you create during project
development, such as screen tags (e.g., buttonl_state) or tags that read from / write to
connected devices.

Classes

Classes are compound tags that you can create to associate a set of values, rather than a
single value, with an object. For example, where you may normally create separate tags for a
tank's pressure, its temperature, and its fill level, you can instead create a "tank" class that
includes all three.

Shared Database

The shared database contains tags that were created in another program and then imported
into or integrated with your project.

System Tags
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System tags are predefined values such as the date, the time, the name of the current user,
and so on. You can use these values to develop supervisory functions and housekeeping
routines.

All system tags are read-only, which means you cannot add, edit, or remove these tags from
the database.

Security

If you choose to enable it, you can use the project security system to control who may log on
to your project and what they may do during runtime.

Procedures

Procedures are VBScript functions and sub-routines that can be called by any other script
in your project.

Event Logger

The event logger saves important runtime messages and task results to an external
database.

Translation

You can use the translation table to develop a multilingual user interface (MUI) for your
project.

Graphics tab

The Graphics tab of the Project Explorer contains all of the screens, screen groups, and symbols in your
project.

Project Explorer o x

v /% Project: Project.APP

..... Screens

----- |, Screen Group

w .|, Thin Clients

i _.L#WEEI

Mobile Access

- Mobile Access Tabular
..... Project Symbols

..... _.' Graphics Script
rﬁl Symbols
@ Layout

@ Global B Graphics| (@ Tasks 7= Comm
Graphics tab of the Project Explorer

The folders on the Graphics tab are described in the following sections:
Screens

You create screens to provide a graphical interface for your project. Each screen can contain
many buttons, sliders, dials, indicators, graphs, and so on.

Screen Groups
You can combine individual screens into screen groups, so that they all open together at the
same time.

Thin Clients
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You can deploy your project as a web application to be accessed by thin clients such as
desktop web browsers, tablets, and smartphones. You can even deploy different versions of
your project with different levels of functionality for each type of client.

Project Symbols

This folder contains all of the custom symbols that you create for your project. A symbol is
a group of interconnected screen objects that work together to perform a single function —

for example, lines, rectangles, and text fragments that have been arranged to make a slider
control.

Graphics Script

You can use this worksheet to define VBScript sub-routines that are called only when the
graphics module starts (i.e., when a client station connects to the server and displays the
graphical interface), while it is running, and when it ends.

Symbols

The symbols library contains not only the custom symbols that you create (see Project
Symbols above), but also a large selection of premade symbols that are installed with the
development application.

Layout

The layout editor displays all of the screens the are currently open for editing. You can use it
to visualize how the screens are arranged together and reuse screens in multiple layouts —
for example, to create a common navigation bar across your entire project.

Tasks tab

The Tasks tab of the Project Explorer organizes the worksheets that are processed as background tasks
(i.e., server-based maintenance tasks that are not directly related to screen operations or device I/0O)
during project runtime.

Project Explorer o x

v /% Project: Project.APP
..... |, Alarms
----- |, Trend
..... |, Recipes
..... |, Reports
..... | Math
o Script
- _-.‘ Startup Script
..... | Scheduler
w .| Database/ERP
.|, Connections

WWclobal B Graphics i Tasks | “J= Comm
Tasks tab of the Project Explorer

The folders on the Tasks tab are described in the following sections:
Alarms

You can use Alarm worksheets to define when alarms are trigged, how they must be
handled, and what messages they generate.
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(You can then use the Alarm/Event Control screen object to display your alarms on screen,
but that is a separate procedure.)

Trends

You can use Trend worksheets to select project tags that should be displayed as data trends
and/or saved as historical data.

(You can then use the Trend Control screen object to actually display your trends on screen,
but that is a separate procedure.)

Recipes

You can use Recipe worksheets to select project tags that will load values from and/or save
values to an external file. These worksheets are typically used to execute process recipes,
but you can store any type of information such as passwords, operation logs, and so on.

(You can then call the Recipe function to actually run a configured Recipe worksheet, but
that is a separate procedure.)

Reports

You can use Report worksheets to design runtime reports that are either sent to a printer or
saved to disk.

(You can then call the Report function to actually run a configured Report worksheet, but
that is a separate procedure.)

Math

You can use Math worksheets to develop complex runtime logic using the built-in scripting
language.

Script
You can use Script worksheets to develop complex runtime logic using VBScript.
Scheduler

You can use Scheduler worksheets to run commands at specified times, dates, or trigger
events.

Database

You can use Database worksheets to set up connections and exchange data with external
databases using the standard ADO.NET interface.
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Comm tab

The Comm tab of the Project Explorer organizes the worksheets that control communication with remote
devices, using either direct communication drivers or other common protocols.

Project Explorer o X

v % Project: Project.APP

----- | Drivers

----- |, OPCDAZ2.05

w. |, OPCUA
Connections

i.. |, Redundancy Group
w - OPCEML/DA

..... |, Connections

- Redundancy Group
..... | TCP/IP

@ Global M Graphics (@ Tasks |73l Comm
Comm tab of the Project Explorer

The folders on the Comm tab are described in the following sections:
Drivers

You can use Driver worksheets to communicate with PLCs and other hardware, using any
of the hundreds of direct communication drivers that are installed with the development
application.

OPC DA 2.05

You can use OPC worksheets to communicate with OPC servers via the OPC Classic
protocol.

OPC UA

You can use OPC UA worksheets to communicate with OPC servers via the new OPC Unified
Architecture protocol.

OPC XML/DA

You can use OPC XML/DA worksheets to communicate with OPC servers via the new OPC
XML-DA protocol.

TCP/IP

You can use TCP/IP worksheets to configure communication between your own project
and other IWS projects. The TCP/IP Client and TCP/IP Server modules enable two or more
projects to keep their databases synchronized using the TCP/IP protocol.
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Screen/Worksheet Editor

Use the powerful, object-oriented screen editor to create and edit a variety of screens and worksheets for
your projects. You can input information using your mouse and keyboard, output control data to your
processes, and automatically update screens based on data input from your processes.

B main.scc = _', SCRIPTOO01 [Language: VBScript] b

Screen/Worksheet Editor

Other screen editor features include:

e Simple point-and-click, drag-and-drop interface

* Grouping objects to preserve the construction steps of individual objects

* Editing objects without having to ungroup internal object components or groups
¢ Handling bitmap objects and background bitmaps

* Status line support in project windows and dialogs
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About Tags and the Project Database

Tags are a core component of any IWS project. Simply put, tags are variables used by IWS to receive and
store data obtained from communication with plant floor devices, from the results of calculations and
functions, and from user input. In turn, tags can be used to display information on screens (and Web
pages), to manipulate screen objects, and to control runtime tasks.

But tags are more than simple variables. IWS includes a real-time database manager that provides a
number of sophisticated functions such as time-stamping of any value change, checking tag values
against runtime minimum and maximum values, comparing tag values to alarming limits, and so on. A
IWS tag has both a value and various properties that can be accessed, some at development and others
only at runtime.

Project Explorer o X

v % Project: Project.APP
v Project Tags

..... |]:] Datasheet View

..... |, Tag List (0]

..... Classes

w - | Shared database

..... |]:] Datasheet View

..... |, Tag List (0]

w | System Tags

----- [[] Datasheet View

- |, Tag List (48]

W Security
» -, Groups
-, Users
w .|, Procedures

- _'. Main Procedures
----- =] Event Logger

----- "ufd] Translation

iGInhal B Graphics @Tasks _j'_{glfnmm

All tags are organized into one of the following categories, which are represented by folders on the Global
tab of the Project Explorer:

¢ Project Tags are tags that you create during project development. Places where project tags are used
include:

¢ Screen tags

e Tags that read from/write to field equipment

¢ Control tags

* Auxiliary tags used to perform mathematical calculations

¢ Shared Database tags are created in a PC-based control program and then imported into IWS's tags
database.

For example you might create tags in SteepleChase and import them into IWS so IWS can read/write
data from a SteepleChase PC-based control product.

You cannot modify shared tags within IWS — you must modify the tags in the original PC-based
control program, and then re-import them into the Tags database.

¢ System Tags are predefined tags with predetermined functions that are used for IWS supervisory
tasks. For example,
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¢ Date tags hold the current date in string format
e Time tags hold the current time in string format

Most system tags are read-only, which means you cannot add, edit, or remove these tags from the
database.

To see a list of the system tags, select the Global tab in the Project Explorer, open the System Tags folder,
and open the Tag List subfolder.

After creating a tag, you can use it anywhere within the project, and you can use the same tag for more
than one object or attribute.
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Understanding the Tag Name Syntax

Observe the following guidelines when naming a tag:

Your tag names must be unique — you cannot specify the same name for two different tags (or
functions). If you type an existing tag name, IWS recognizes that the name exists and will not create
the new tag.

You must begin each tag name with a letter. Otherwise, you can use letters, numbers, and the
underscore character (_) in your tag name.

You cannot use the following symbols in a tag name:

~te#s$sre* ()-=\N+\N[1{}<>>?

You can use a maximum of 255 characters for a tag name or a class member name.You can use
uppercase and lowercase characters. Tag names are not case sensitive. Because IWS does not
differentiate between uppercase and lowercase characters, you can use both to make tag names more
readable. (For example: TankLevel instead of tanklevel.)

Tag names must be different from system tag names and math functions.

g Note: Use the @ character at the beginning of a tag name to indicate that the tag will be used as
an indirect tag in the project.

Some valid tag examples include:

Temperature
pressurel
count

X
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Choosing the Tag Data Type

Another consideration when designing a tag is what type of data the tag will receive. IWS recognizes the
following, standard tag data types:

Boolean (one bit): Simple boolean with the possible values of O (false) and 1 (true). Equivalent to the
"bool" data type in C++. Typically used for turning objects off and on or for closing and opening objects.

Integer (four bytes): Integer number (positive, negative, or zero) internally stored as a signed 32-bit.
Equivalent to the "signed long int" data type in C++. Typically used for counting whole numbers or
setting whole number values. Examples: 0, 5, =200.

Real (floating point, eight bytes): Real number that is stored internally as a signed 64-bit. Equivalent to
the "double" data type in C++. Typically used for measurements or for decimal or fractional values.

String (alphanumeric data, up to 1024 characters): Character string up to 1024 characters that holds
letters, numbers, or special characters. Supports both ASCII and UNICODE characters. Examples:
Recipe product X123, 01/01/90, *** On ***,

You can also assign a new tag to a class that you have previously created.

You can find these tag types (and their respective icons) in the Global tab of the Project Explorer.
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Using Array Tags

IWS tags can consist of a single value or an array of values.

g Note: The maximum array size is 16384 as long as it does not exceed the maximum number
of tags supported by the license (Product Type) selected for the project. Each array position
(including the position 0) counts as one tag for licensing restrictions, because each position has
an independent value.

An array tag is a set of tags with the same name, which is identified by indexes (a matrix of n lines and 1
column). The maximum array size depends on the product specification. You can use the following syntax
to access an array tag:

ArrayTagName[ArrayIndex]

For example: tank[0], tank[1], tank[2], and tank[500].

¢ Note: You must specify a maximum index for each array tag in the size column of any datasheet.
You can specify n to indicate the array tag has positions from O to n. For example, if the size of
TagA is 3, the tag elements could be TagA[0], TagA[1], TagA[2], and TagA[3].

Use the array tag whenever possible because it optimizes memory use and simplifies the configuration

task. For example, if you want a display to monitor each tank, you could use array tags to configure a

single display containing tags linked to any tank. For example (using the tk tag as an index containing
the number of the tank): pressure[tk], temperature[tk], and temperature[tk+1].

An array index can be a tag, a numeric value, or an expression with the arithmetic operator "+".

g Note: When you refer to an array with an index using the + arithmetic operation, you must use
the following syntax:

ArrayTagName [ NumValuel+NumValueZ2]

Where NumValuel and NumValue2 can be an integer tag or a numerical constant. For example:
temperature[tk+2] or temperature[tk+6].

Using array tags in any IWS task can save a signification amount of project development time. For
example, if you needed tag points related to the temperature of four tanks. The conventional configuration
method is the following:

¢ temperaturel: high temperature on tank 1
¢ temperature2: high temperature on tank 2
¢ temperature3: high temperature on tank 3
* temperature4: high temperature on tank 4
Using array tags simplifies this task, as follows:

* temperaturelj]: high temperature on tank {j}

g Note: When you create a four-position array tag, the system creates five positions (from O to 4).
For example:

tag_example[l5] //start position=0, end position=15

Therefore, the tag_example[15] array has 16 elements.

When using another tag to reference the index of an array, if the value of the tag is outside the size of the
array, then the following results are given:

e If IndexTag is greater than the size of the array, then MyArray [ IndexTag] will point to the end
position of the array; and

e If IndexTag is less than O, then MyArray [ IndexTag] will point to the start position of the array.
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Array Tags

An array tag consists of a set of tags that all have the same name, but use unique array indexes (a matrix
of nlines and one column) to differentiate between each tag. An array index can be a fixed value, another
tag or an expression. Maximum array sizes are determined by product specifications.

You can use array tags to:

¢ Simplify configurations

¢ Enable multiplexing in screens, recipes, and communication interfaces
e Save development time during tag declaration

You specify array tags in one of two formats:

e For a simple array tag, type:
ArrayTagName[ArrayIndex]

e For a complex array tag (where the array index is an expression consisting of a tag and an arithmetic
operation), type:

ArrayTagName[ArrayIndex+c]

Where:

e ArrayTagName is the tag name;

* [ArrayIndex] is the unique index (fixed value or another tag);
* +is an arithmetic operation; and

e cis a numerical constant.

i Note:

*  You must specify a maximum index for each array tag by typing a value (n) in the Array
Size column of an Project Tags datasheet or in the Array Size field on a New Tag dialog.

When you create an n-position array tag, IWS actually creates n+1 positions (from O to n). For
example, if you specify ArrayTag[15], the array will have 16 elements, where O is the start
position and 15 is the end position.

* You must not use spaces in an array tag.

When IWS reads a tag it begins with the first character and continues until it finds the
first space or null character. Consequently, the system does not recognize any characters
following the space as part of the array tag.

For example, if you type a[second + 1], IWS regards a[second as the tag and considers
it invalid because IWS does not find (recognize) the closing bracket. However, if you type
a[second+1], this is a valid array tag.

You can specify an array tag wherever you would use a variable name. Also, because array tags greatly
simplify configuration tasks and can save development time, we suggest using them whenever possible.

For example, suppose you want to monitor the temperature of four tanks. The conventional configuration
method is:

* temperaturel — high temperature on tank 1

* temperature2 — high temperature on tank 2

* temperature3 — high temperature on tank 3

* temperatured4 — high temperature on tank 4

You can use array tags to simplify this task as follows (where [n] represents the tank number):
* temperature[n] — high temperature on tank [n]

The following table contains some additional examples of an array tag:
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Array Tag Examples

Array Tag Example Description

Tank[1l],Tank[2],Tank[500] Simple arrays, where the array indexes (1, 2, and 500) are numerical
constants. For example, tank numbers.

Tank [ tk] A simple array, where the array index (tk) is a tag. For example, a tag
representing the tank number.

Tank[tk+1] A complex array, where the array index (tk+1) is an expression. For
example, the value of tk (tank number) plus 1.

¢ Note: When using another tag to reference the index of an array, if the value of the tag is
outside the size of the array, then the following results are given:

e If IndexTag is greater than the size of the array, then MyArray [ IndexTag] will point to the
end position of the array; and

e [If IndexTag is less than O, then MyArray [ IndexTag] will point to the start position of the
array (i.e., MyArray[0]).
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About indirect tags

IWS supports indirect access to tags in the database. For example, consider a tag X of the String type.
This tag can hold the name of any other tag in the database (that is, it can provide a pointer to any other
type of tag, including a class type). The syntax for an indirect tag is straightforward: @ IndirectTagName.
For example, assume that a tag named X holds a "TEMP" string. Reading and/or writing to @X provides
access to the value of the TEMP variable.

¢ Note: Any tag created as a string-type tag is potentially an indirect tag (pointer).

To refer to a class-type tag, you can declare a string-type tag that points to a class tag. For example:

Class TANK with members Level
Tag TK of the class TANK
Tag XCLASS of the String type

To access the TK.Level value, you must store the " TK.Level" value within the XCLASS tag and use the
syntax, @XCLASS. You can also refer to a member of a class-type tag directly; identifying a class-type that
points to a class member.

For example:

Class TANK with members Level
Tag TK of the class TANK
Tag XCLASS of the class TANK

To access the TK. Level value, you must store the "TK" value within the XCLASS tag and use the syntax,
@XCLASS.Level.

When creating tags for indirect use, place an X in the tag column rather than creating them as strings.
For the type, write the type of tag for which you are creating a reference. Follow the XCLASS example: @2
Integer, @X Class:TANK.

Indirect Tags

Indirect tags "point" to other database tags (including class-type tags). Using indirect tags can save
development time because they keep you from having to create duplicate tags (and the logic built into
them).

You create an indirect tag from any string-type tag simply by typing the @ symbol in front of the tag name
@TagName.

* To reference a simple tag, assume the strX tag (a string tag) holds the value "Tank", which is the
name of another tag, then reading from or writing to @strX provides access to the value of the Tank
tag.

¢ To reference a class-type tag and member, you simply create a string tag that points to the class tag
and the member. For example, if a tag strX (a string tag) holds the value "Tank.Level", which is
the name of the class tag, then reading from or writing to @strX provides access to the value of the
Tank.Level member.

* You can also point directly to a class-type tag member; by identifying a class-type that points to a class
member. For example: to access the Tank.Level member of the class, you must store the "Tank"
value within the strX tag and use the syntax, @strX.Level.
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Tutorial: Building a Simple Project

This section explains, using a step-by-step tutorial, how to build a simple project, as well as how to select
and configure an I/O driver.
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Creating a new project

This part of the tutorial shows how to create a new project, including how to give it a name and then
select the target platform and system.

1. Click the Application button in the top-left corner of the development environment, and then click New
on the Application menu.

The New dialog is displayed.
2. Click the Project tab.

3. In the Project name box, type the name of your project.
For this tutorial, type Tutorial.
The development application automatically creates a new directory of the same name and assigns your
project file to that directory. (Notice the Configuration file text box in the figure.) To put your project file
somewhere other than in the default projects folder, click Browse and navigate to the preferred location.

4. In the Product type list, select the type of project that you want to build.

For this example, select Embedded Standard. This is a tag and feature-limited product type that can be
safely deployed on embedded devices.

Mew
Project l . . - -
r Create new Project with the specified settings
&
File

Project name:

| Tutorial

Location:

| C:\Projects | Browse
Configuration file:

| CAProjects\TutoriahTutorial.app

Target platform®: (A e

Product type*:
Windows Operator Workstation Plus  JEpla=sebi=s BTl Bl Embedded Lite
Windows Operator Workstation Windows Lite Interface Plus
Embedded Professional Embedded Lite Plus

Windows Local Interface Windows Lite Interface
£ >
Standard for Windows Embedded (1500 tags)

*Select Windows target platform for Windows Server/Deskiop projects. Select Embedded target

platform for Windows Embedded and loTView projects (Windows Embedded Compact (Windows CE),

Windows Mobile, Linux, WxWorks, etc.).

*you can moedify the target platform and product type after creating the project by using the Project tab.

Cancel
Selecting the target platform and product type
S. Click OK.

The New dialog is closed and the Project Wizard dialog is displayed.
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6. In the Resolution list, select 1024 x 768.

Project Wizard

Dizplay
R ezalution:
1024 = 753 e

Cancel

Specifying an empty Application with 1024x768 resolution

7. Click OK.

The Project Wizard dialog is closed, the project is created in the development environment, and the
Security System Configuration Wizard is displayed.

fI3 Security System Configuration Wizard

Overview This wizard will help you to configure the new Security System.
These are the cument securty settings: |zers: Groups:
Security System is enabled. Guest Guest
[Local Mode]
[Local Made]: GOOD
Do not automaticaly show this wizard next time you open Security.
< Previous Mext = Cancel

Security System Configuration Wizard

8. Use the Security System Configuration Wizard to set a Main Password for your project.
The security system is enabled by default for all new projects.

When you finish the Security System Configuration Wizard, your new project is ready for development.
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Specifying the startup screen

This part of the tutorial shows how to open the project settings and then specify which screen should be
displayed on startup.

Use the Information tab to provide information that identifies the project (such as project description,
revision number, Company name, Author's name, field equipment, and general notes).

Use the Options tab to specify generic settings for the project, such as the Target System, Automatic
Translation, Alarm history and Events, Default Database and Shared Tags.

Use the Viewer tab to enable/disable the runtime desktop parameters.
Use the Communication tab to specify communication parameters relating to the project in general.

Use the Preferences tab to enable/disable warning messages when using the development application.

To specify the startup screen:

1.

On the Project tab of the ribbon, in the Settings group, click Viewer.
The Project Settings dialog is displayed with the Viewer tab selected.

. In the Startup screen box, type main.scc.

When you run the project, it will automatically display the main screen (or whichever screen you
specify) first. You can specify a screen before you create it, but if the screen has been created, then you
can also select it from the list.

Click OK.
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Creating tags

This part of the tutorial shows how to create new tags by adding them to the Project Tags datasheet.

A tag is any variable that holds a value. All tags created in a project are stored in the Project Tags folder,
on the Global tab of the Project Explorer.

Project Explorer o x

LT --’.h t.'.. = 3
-1, Project Tags
- |I] Datasheet View

.|, TagList (0]

Shared database
- |, System Tags
- Security

) - | Procedures

----- = Event Logger
.. Translation
'ﬂGInbal B Graphics @Task.s j’_{gCnmm
Project Tags folder

In the Project Explorer, click the Global tab.
Double-click Project Tags to expand the folder.
Double-click Datasheet View to open the Project Tags datasheet.

> W=

Use the following parameters to create a tag for the sample project.
a) Name: Specify a unique tag name. For this tutorial, type Level.

b) Array: Specify the top array index of the tag. (Simple tags have an Array of 0.) For this tutorial, type
3.

Each array index relates to one of the three tanks:

e Level[1l] is the level of Tank #1

¢ Level[2] is the level of Tank #2

¢ Level[3] is the level of Tank #3

You will not use Level [0] in this tutorial, even though it is a valid tag.

c) Type: Specify the data type of the tag: Boolean, Integer, Real, String, or Class. For this tutorial, select
Integer.

d) Description (optional): Type a description of the tag for documentation purposes only.
e) Scope: Specify how the tag is managed between the Server and the Thin Client stations.
e Select Local if you want the tag to have independent values on the Server and Client stations.

* Select Server if you want the tag to share the same value on the Server and Client stations.
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For this tutorial, select Server.

m Project Tags =
Mame Array Type Drescription Scope LA External Availability
‘<&, Filter text P (A ¥ |4 Filter text L (A v A v
1 |IF":| Level 3 Integer ¥ Level ofthe tank Server ¥ Disabled hd
* | | Integer h Server ¥ Disabled W
& Imtenar L Cansar W  Nicahlad
Creating the Level tag

5. Save and close the Project Tags datasheet.

You will create additional tags as you build the project.

"

Tip: You can sort the data in the Project Tags datasheet or insert/remove additional columns by
right-clicking on it and then choosing the applicable option from the pop-up menu.

Page 55



Tutorial: Building a Simple Project

Creating the main screen

This part of the tutorial shows how to create your first screen, which will contain a single button that
opens another screen.

1. In the Project Explorer, click the Graphics tab.

Project Explorer

~ ‘% Project: Project.APP
..... |, Screens

..... |, Screen Group

w .| Thin Clients

..... [igd Web

Maobile Access
o Mobile Access Tabular
..... |, Project Symbols

..... =_.'“ Graphics Script

rﬁl Symbols

@ Layout

@Global B Graphics @Tasks j':'f:!C::umm

2. Right-click Screens, and then click Insert on the shortcut menu.
The development application stores all screens created for a project in this Screens folder.
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The Screen Attributes dialog is displayed.

Screen Attributes -
Description: |
Backaround Picture Size Lacatian
Enable Background BMP o Wwiidth: Top: ICI
[1 Shared image: Height: | 7568 Left: ICI
Runtime Properties Security
Titlebar: | Level ICI
al .

Sztem Menu Style: Replace(Partial) w Screen Logic

Border: : -
inimize Box L. [ Br D2
Dan't redraw: | | (] ‘while Open..
Disable Commands: | | [ On Close...

Multi Touch Settingz

Focus Performance Optimization
Receive focus on open Tab Order. [ ] Hide sereen instead of clozing it

Share tab order with other screens Izl [ Keep screen file in memory
[ ] Background screen

Cancel

Screen Attributes dialog

. Use this dialog to set screen properties such as size and type.
For this tutorial, click OK to accept the default settings.
The Screen Attributes dialog is closed, and the new screen is opened in the workspace for editing.

. On the Graphics tab of the ribbon, in the Screen group, click Background Color.
A standard color picker is displayed.

. In the color picker, select a light gray color.

Theme Colors

Standard Colors

Edit Custom Colors 4
Fill Effects...
Color picker

That color is applied to the screen.
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Drawing the main screen's title
This part of the tutorial shows how to draw the main screen's title using a Text object.

1. On the Graphics tab of the ribbon, in the Active Objects group, click Text.
Your mouse cursor changes from an arrow to a crosshair.

2. Click on the screen, type Welcome to the Tutorial Application, and then press Return.
This creates a new Text object with the specified text.

3. Double-click the object to open its Object Properties dialog.

Object Properties n
=" Feplace... Hint: | Text e
Caption; | Text data link...
Aligr: | | et ~ Fants

[ ]Barder - []Background:  |[ |+

Enable translation

Object Properties: Text dialog

¢ Double-clicking on any screen object opens an Object Properties dialog containing the properties for
that object. The properties shown in the dialog change depending on the type of object.

* The Object Properties dialog also contains a pin button that controls whether this dialog remains
open. The button changes state (and function) each time you click on it, as follows:

* When the pin button is released, the focus is passed to the object on the screen as soon as it
is selected. It is recommended that this button is kept released when you want to manipulate
the objects (Copy, Paste, Cut, or Delete). Although the Object Properties dialog is on the top, the
keyboard commands (Ctrl+C, Ctrl+V, Ctrl+X, or Del) are sent directly to the objects.

¢ When the pin button is pressed, the focus is kept on the Object Properties dialog, even when you
click the objects on the screen. We recommend you keep this button pressed when you want
to modify the settings of the objects. You can click an object and type the new property value
directly in the Object Properties dialog (it is not necessary to click on the window to bring focus
to it). Also, when the pin button is pressed, the Object Properties dialog does not automatically
close when you click on the screen.

4. Click Fonts to open Font dialog, and then specify the font settings.
For this tutorial...

* Font is Arial
¢ Font style is Regular

e Sizeis 20
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¢ Color is Blue

Font >
Font Font Style Size
Arial Regular 20
A z < [
T Arial Black Narrow Bold 11
T Arial Narrow . 12
T Arial Rounded MT Narrow Bold ltalic 14
% Arial Unicode MS Bold 16
Bahnschrift Bold Italic 18
® Bahnschrift Light Black
Tr Rahnerhrift SamiRn ¥ v o[22 ~
Effects Sample
[ ] 5trikeout
AaBbYyZz
] Underline
Color Script

- [ -]

Show more fonts

Ok Cancel

Specifying the font settings
5. Click OK to close the Font dialog.
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The font settings are applied to the Text object.

N Caption: | Welcome to the Tutorial Application | Teut data link... B
B Algr: | Len y Forts b
[] Border: l? [ ] Background: Iﬁ
. [*] Enable translation

Font settings applied to Text object

6. Close the Object Properties dialog (i.e., click the Close button in the dialog box's top-right corner).

Drawing a button to open another screen

This part of the tutorial shows how to draw and configure a button that will open another screen.

1.

On the Graphics tab of the ribbon, in the Active Objects group, click Button.
Your mouse cursor changes from an arrow to a crosshair.

2. Click and hold on the screen, and then drag the cursor to draw the Button object.

3. Double-click the object to open its Object Properties dialog.
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4. In the Caption box, type the following text: Click here to open the synoptic screen.

B Screen2 =

R - Replace... Hirt: Button “
o Captior;

------ Click here to open the svnoptic screen

N Style: | 30 Sharp v Background calar: ||:|v Align: |[=]
N Fonts. .. Images Adwvanced... Command

Adding a caption to the button
. Click Command.

The Object Properties dialog changes to show the properties for the Command animation.

6. In the Type list, select Open Screen.

In the Open Screen box, type synoptic.scc.

Object Properties

="} Hint:

Replace...

Cormmand

St

Open Screen Config...

Type:

OnDown  On'while OnlUp

Qpen Screen

Back to button...

| syvnoptic.scc

Configuring an Open Screen command on

You can specify a screen that you have not yet created.

the button
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8. Close the Object Properties dialog.

Saving and closing the main screen
This part of the tutorial shows how to properly save and close a screen.

1. Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.
A standard Windows Save dialog is displayed.

2. In the File name box, type main.

3. Click Save.
The file is saved in your project folder (at <project name>\Screen\main.scc), and the Save dialog is
closed.

4. Click the Application button at the top-left of the development environment, and then click Close on the
Application menu.
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Creating the synoptic screen

This part of the tutorial show how to create your second screen, which will include an animated tank of
liquid and some basic controls for that tank.

1. In the Graphics tab of the Project Explorer, right-click the Screens folder, and then click Insert on the
shortcut menu.
The Screen Attributes dialog is displayed.

2. Use this dialog to set attributes such as size and type.
For this tutorial, click OK to accept the default settings.

3. Click the Application button at the top-left of the development environment, and then click Save As on
the Application menu.
A standard Windows Save As dialog is displayed.

4. In the File name box, type synoptic.

5. Click Save.
The file is saved in your project folder (at <project name:gt;\Screen\synoptic.scc), and the Save
dialog is closed.

Do not close the screen like you did the main screen when you saved it. You still need to draw the
synoptic screen.
Drawing the synoptic screen’s title

As in a previous part, this part of the tutorial shows how to draw the synoptic screen's title using a Text
object.

1. On the Graphics tab of the ribbon, in the Active Objects group, click Text.
2. Click on the screen, type Synoptic Screen, and then press Return.
3. Double-click the object to open its Object Properties dialog.

4. Click Fonts to open Font dialog, and then specify the font settings.
For this tutorial...

* Font is Arial

* Font style is Bold

* Size is 20

e Color is Blue

Click OK to save the font settings and close the dialog.
Close the Object Properties dialog.

Move the Text object to the top left corner of the screen.

®» N o o

Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.

This figure shows how your screen should look after you have drawn the screen title.

Finished screen title

Drawing "Date” and "Time" displays

This part of the tutorial shows how to draw "Date" and "Time" displays by linking Text objects to system
tags.

Date and Time are system tags that hold the current date and time of the local station. These tags are
available to any project.

1. On the Graphics tab of the ribbon, in the Active Objects group, click Text.
2. Click on the screen, type Date: ##########, and then press Return.
3. Double-click the object to open its Object Properties dialog.
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4. Click Text Data Link.
The Object Properties dialog changes to show the properties for the Text Data Link animation.

5. In the Tag/Expression box, type Date.

Object Properties n
=) Replace... Hint:l | Text Data Link w
T ag/E #pression: D;&-!_._‘) |
Format: | Auto ~ | []Input Enabled Back totext...
Pazsword [ ] Auta Size []RTL 0
[ JE-Sign Require confirmation <llse Default=

Specifying the Date system tag

During runtime, the project replaces the ########## characters of the Text object with the value of the
system tag Date.

Close the Object Properties dialog.
On the Graphics tab of the ribbon, in the Active Objects group, click Text.
Click on the screen, type Time: ##########, and then press Return.

© o N o

Double-click the object to open its Object Properties dialog.

10.Click Text Data Link.
The Object Properties dialog changes to show the properties for the Text Data Link animation.

11.In the Tag/Expression box, type Time.

Object Properties n

=) Replace... Hint:l | Text Data Link w

—

T ag/Esprezsion; |Tirn_&=r_) |

Format: | Auto ~ | []Input Enabled Back totexst...
Pazsword [ ] Auta Size []RTL 0
[ JE-Sign Require confirmation <llse Default=

Specifying the Time system tag
During runtime, the project replaces the ########## characters of the Text object with the value of the
system tag Time.
12.Close the Object Properties dialog.

13.Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.
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This figure shows how your screen should look after you have created the date and time objects.

Finished date and time objects

Placing an "Exit" icon

This part of the tutorial shows how to place an icon (by selecting and configuring a Linked Symbol) that
allows the user to exit the project, .

1.

On the Graphics tab of the ribbon, in the Libraries group, click Symbols.
The symbols library is displayed.

2. In the Symbols menu tree, open the System Symbols folder and then open the lcons sub-folder.

3. In the Icons sub-folder, select exit01.

The symbol will be displayed in the symbol viewer to the right of the menu tree.

B synoptic.scr |ﬁ| Symbols =

|ﬁ| Symbols S
i | Project Symbals
- Systemn Symbols

~ |, Architecture

< Arows

~ |, Bargraphz

-~ |, Buildingtutomation

~ |, Buttons

~ |, Command

-« DateTime

<, Ducts
-, Faceplates @ ﬁ ==
-+, Fanz
<, lcons
<1, Indicatars excel exclamation _-_
<, Meters
bl ctors
FilotLight=

§

databaseSpy db dbDatalink

Selecting the "exit01" symbol

Click on the symbol.
The mouse cursor will change to show that the symbol is ready to be placed in a screen.

Switch back to the screen where you want to place the symbol and then click in it.
The symbol is placed as a Linked Symbol object.

SYNOPtic Screen  daie: sk Time: s 1=

Placing the Linked Symbol object

With the object still selected, click Command (on the Graphics tab of the ribbon, in the Animations group) to
apply this animation to the object.

7. Double-click the object to open its Object Properties dialog.
8. In the Type list, select VBScript.
9. In the OnDown box, type $Shutdown ().
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Shutdown is one of InduSoft Web Studio's built-in scripting functions, but it can be used within
VBScript by prefacing it with a dollar sign ($).

Object Properties n
=) Replace... H int:l Command v
Type: | VBScript e Corfig...

OnDown  On'while OnUp

1| $Shutdown()

Specifying the Shutdown command on the symbol
10.Close the Object Properties dialog.

11.Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.

Now, when a user clicks this icon during runtime, the project will stop and exit to the station's desktop.

Testing the project
This part of the tutorial shows how to test the project so far.

1. Click the Application button at the top-left of the development environment, and then click Close > Close
All on the Application menu.
All open worksheets are closed.

2. On the Home tab of the ribbon, in the Local Management group, click Run.
The project runs and the startup screen is displayed.

3. Click the button to open the synoptic screen.
The synoptic screen is displayed.

4. Click the exit icon to shut down the project.

If any part of the project does not work as expected, switch back to the development application (ALT+TAB)
and then click Stop on the Home tab of the ribbon.

Placing an animated tank

This part of the tutorial shows how to select an animated tank from the Symbol Library and place it on
the screen (similar to how you selected and placed the "Exit" icon), then associate some project tags with
the tank's properties.

1. In the Graphics tab of the Project Explorer, expand the Screens folder.

2. Double-click synoptic.scc.
The synoptic screen worksheet is reopened for editing.

3. On the Graphics tab of the ribbon, in the Libraries group, click Symbols.
4. In the Symbols menu tree, open the System Symbols folder and then open the Tanks sub-folder.

5. Browse the tank symbols and choose one.
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You may choose any tank symbol that you like; they all function basically the same.

B ' synoptic.ser |ﬁ| Symbols =

-
< Ao s s
-~ Bargraphs
-+ Buildingdutamation
-, Buttonz
-~ Command
"l DateTime tank07 tank08 tank09
-« Ductz
-~ Faceplates
-, Fans
<, lcong
<1 Indicators
<1, Meters
« 1, Maotars
-« PilotLights
~ 1. Fipes tank10 tank11 tank12
<, Platez
<, Pumps
<1, PughButtons
<, Sliders
<1 Switches
Tarks - N
Textl0

Choosing a tank symbol

. Click the symbol.
The mouse cursor will change to show that the symbol is ready to be placed in a screen.

. Switch back to the screen where you want to place the symbol and click in it.
The symbol is placed as a Linked Symbol object.

. Double-click the object to open its Object Properties dialog.

Object Properties n
= Replace... Hint:l | Linked Symbol w

M arne: |Tﬂ|‘|k3".tﬂl‘lk1ﬂ.5‘_fl‘l‘l | Usze linked size

Category: [] Display properties from all categonies

(Main | Property Value

Max 100 |
Min 0
Taglevel K AnalogValue_

The tank symbol's properties

A tank is an arrangement of different objects and animations (for example a rectangle, a bar graph,
etc.), all combined together as a Linked Symbol. You can modify the properties of this symbol by
editing the properties list. For this tutorial, you will modify the tag associated with the tank level.

. For the property TagLevel, delete the existing value and then type Level [Index].

Note that you do not need to reopen the Project Tags datasheet to create tags as you develop the
project.

Because you have not previously created the tag Index in the Project Tags database, an alert message
asks you if you would like to create it.
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10.Click Yes.
A New Tag dialog is displayed.

11.Configure the new tag with Array as 0, Type as Integer, and Scope as Local.

Mew Tag

M ame:
Array;

Type:

Scope:

| Index

o |

Integer

Dezcription: | Tag index number

Local

S

Cancel

12.Click OK to close the New Tag dialog.

Configuring a new tag

You can use the tag Index to set the array position of the tag Level, and show the level for any of the

three tanks in the same object:

e When Index equals 1, the tank object shows the level of Tank #1 (i.e., Level[1]);

¢ When Index equals 2, the tank object shows the level of Tank #2 (i.e., Level[2]); and

* When Index equals 3, the tank object shows the level of Tank #3 (i.e., Level[3]).

Also, because the tag scope is local, the tag can have different values for the Server and Client stations
at the same time. Consequently, the local user (i.e., the Server station) can be monitoring the level of
Tank #1 while the remote user (i.e., the Client station) is monitoring the level of Tank #2.

13.Close the Object Properties dialog.

14.Click the Application button at the top-left of the development environment, and then click Save on the

Application menu.

This figure shows how your screen should look after you've created the tank object.

Synoptic Screen

Placing a level slider

=

Diste; Ssiaskane | | Time: shsosssd

Finished tank object

i1 |

This part of the tutorial shows how to select a slider control from the Symbol Library and then connect it

to the animated tank.

1. On the Graphics tab of the ribbon, in the Libraries group, click Symbols.
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2. In the Symbols menu tree, open the System Symbols folder and then open the Sliders sub-folder.

B " synoptic.sce ﬁl Symbols -

<, Buildingfutomation ~
<, Buttonz
-« Command

-, DateTime o i & aza .

. Ducts Minimal_BlackSliderL... Minimal_BlackSliderL... Minimal_WhiteSlider...
-« Faceplates
-, Fans

<1, lconz

<. Indicators

<, Meterz

<1, Motorz

-, PilotLights

-~ 1, Pipes

~ |, Plates Minimal_WhiteSlider...
-« Pumpsz

<, PuzhButtons
-, Slhiders

<1 Switches

« . Tanks
TacHn

1006

g

Ex

*

¢

shder(2

i

You may select any slider you like; they all function basically the same way.

4. Click on the symbol.
The mouse cursor will change to show that the symbol is ready to be placed in a screen.

Selecting a slider symbol

3. In the Sliders sub-folder, select a slider control.

5. Switch back to the screen where you want to place the symbol and click in it.
The symbol is placed as a Linked Symbol object.

6. Double-click the object to open its Object Properties dialog.

7. For the property TagName, delete the existing value and then type Level [Index].
Just as with the tank, you need to modify the symbol property associated with the slider level.

8. Close the Object Properties dialog.

9. Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.

This figure shows how your screen should look after you've created the level slider object.

Finished level slider object
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Drawing a tank selector

This part of the tutorial shows how to draw a text input box that can be used to change which real-world

tank is represented by the animated tank on the screen.

1. On the Graphics tab of the ribbon, in the Active Objects group, click Text.
2. Click on the screen, type Tank: #, and then press Return.

3. Double-click the object to open its Object Properties dialog.

4. Click Text Data Link.

The Object Properties dialog changes to show the properties for the Text Data Link animation.

5. In the Tag/Expression box, type Index.

6. Select the Input Enabled option.
This allows the operator to enter a new value for the tag during runtime.

7. In the Minimum Value box, type 1.
8. In the Maximum Value box, type 3.

Object Properties

=3 Replace... Hint:l | Text Data Link

St
T ag/Exprezsion: | Index |
Format;, | Auto o Input Enabled Back to text...
kirirnuim Y alue: | 1 |
b asirnuinn W alue; | 3 |
Dizable; | |
[ ] Password Auto Size [ 1RTL Security: IZI
[]E-Sign [ Require confirmation <llse Default=

Configuring the "Tank" text input
9. Close the Object Properties dialog.

10.Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.

This figure shows how your screen should look after you've created the tank selector object.

Synoptic Screen Dpate: 071772018  Time: 09:23:41 ﬂ

.

&

!

Finished tank selector object during runtime
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Testing the project

This part of the tutorial shows how to test the project again with the animated tank, the level slider, and
the tank selector.

1.

5.

Click the Application button at the top-left of the development environment, and then click Close > Close
All on the Application menu.
All open worksheets are closed.

. On the Home tab of the ribbon, in the Local Management group, click Run.

The project runs and the startup screen is displayed.

Click the button to open the synoptic screen.
The synoptic screen is displayed.

Type the tank number (1, 2, or 3) in the Tank label, and then use the slider to adjust the tank level.
Note that you can view/adjust the level of each tank independently.

Click the exit icon to shut down the project.

If any part of the project does not work as expected, switch back to the development application (ALT+TAB)
and then click Stop on the Home tab of the ribbon.
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Configuring the communication driver

This part of the tutorial shows how to select and configure a driver to communicate with an external I/O

device.

1. In the Project Explorer, click the Comm tab.

2. Right-click the Drivers folder, and the click Add/Remove Drivers on the shortcut menu.
The Communication Drivers dialog is displayed.

3. Select a driver from the Available drivers list, and then click Select.

For this tutorial, select MODBU.

The driver is moved to the Selected drivers list.

Communication Drivers

Ayailable drivers:

DLL Dezcription
MODPL  MODEUS PLUS Pratocal [+1.11]

MOLOW  MOLOW Protocol RTUAASCH [+1.1]

kA Pl SIEMEMS, MPIl Pratocal - 57 [+1.30]
kPLAD SIEMEMS, MPI Green Cable Protocal
£

MODSL Frotocol ModBusz Slave[A5CH and RTU)[Senal and TCFAR) [CE)[3.2]

MOTCP  MODEBUS Protocol RTU via TCPAR [CE] [+10.18]

- 3964R [CE] [+1.0]

Help

I Select »» I

Selected drivers:

DLL Ciescription »» Remave
":.__h-d__EIDEU MODEBUS Protocol RTUAASCH [CEY [+10.12] >
L4
ak. Cancel
MODBU driver selected
4. Click OK.

The Communication Drivers dialog is closed, and the driver is added to the Drivers folder in the Project

Explorer.
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Project Explorer
w % Project: Tutorial. APP

w .| Drivers

.~ .|, MOpEL

..... | OPCD Insert

, .|, OPCU :

L. TCR/IP akkin:
Help

o

x

P Giobal M Graphics (@ Tasks = Comm

The Communication Settings dialog is displayed.

5. In the Project Explorer, right-click the MODBU folder, and then click Settings on the shortcut menu.

Signed/Unzsigned:

w MODELU:
Sernal N
E ncapsulation: one ™
Serial Port
COM: COom1 w | Stop Bits:
Baud R ate: 9800 w | Pariby;
Data Bits: a w

None

ProtocolfdSCH or RTU]:

Unsigned i | RTU

Swap - Write Type:

Block Size # [ERD-xmm): M axz ap:

Mo Swap / Write tem et | 64

Advanced...

Cancel

Communication Settings dialog for MODBU driver

. Configure the communication settings as needed for the target device.

For this tutorial, accept the default settings.

of the ribbon.

g Note: For more information about a specific driver, click Communication Drivers on the Help tab

7. Click OK to close the dialog.

8. In the Project Explorer, right-click the MODBU folder and then click Insert on the shortcut menu.

A new driver worksheet named MODBU0O1 .drv is created and opened for editing.

. Configure the worksheet header:
a) In the Description box, type Tutorial Modbus.

This setting is for documentation only; it does not affect the runtime project in any way.

b) In the Enable Read When Idle box, type 1.

This setting is a trigger that takes a Boolean value. A value of 1 — either entered manually as above
or evaluated from a tag/expression — forces your project to continue reading tag values from the

target device even when there are no changes in value.

c) In the Enable Write On Tag Change box, type 1.
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This setting is also a trigger. A value of 1 forces your project to write tag values to the target
device only when those values change, rather than continuously. This saves system resources and
improves performance during rutime.

d) In the Station box, type 1.
This indicates the I/O device number to be accessed by this driver. Typically, the PLC is specified as
Device #1.

e) In the Header box, type 4X:0.

You must use a driver-specific format. The format for the MODBU driver is:

register_ type:initial offset

Register Type Description

0X Coil Status

1xX Input Status

3X Input Register
4X Holding Register
D Slave ID Number

W MODBUOM.DRV

Diescriptian:

| Tutorialodbus | [increase pricrity

Fead Trigger: Enable Read when ldle: Read Completed: Fead Status:

| K - I |
wiite Trigger: Enable 'Wiite an Tag Change: Wiite Completed: Wirite Status:

| Ik o o |
Station: Header.

K | [exo | O

Tag Mame Address Div Add

Completed worksheet header

10.In the worksheet body, enter the tags and their associated device addresses — for each tag:
a) In the Tag Name field, type the name of the project tag.

b) In the Address field, type the value to be added to the header to form the complete device address.

Tag Name Address Complete Device Address
Level[1l] 1 4X:1 (Holding Register 1)
Level[2] 2 4X:2 (Holding Register 2)
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Tag Name Address Complete Device Address
Level[3] 3 4X:3 (Holding Register 3)
|1 | | 4x0 | [
Tag Mame Address Div Add
(& Filter text (& Filter text & Filtertext |4 Filter text
1 Level[1] 1 0.000000 0.000000
2 Levell2] 2 0.000000 0.000000
3 Level[3] 3 0.000000 0.000000

Completed worksheet body

11.Click the Application button at the top-left of the development environment, and then click Save on the
Application menu.

12.When prompted to choose the driver sheet number, type 1 and then click OK.

Monitoring device I/O during runtime
This part of the tutorial shows how to monitor device I/O during runtime by using the Log window.

1. On the Home tab of the ribbon, in the Local Management group, click Run.
The project runs and the startup screen is displayed.

2. Press ALT+TAB to switch back to the development application.

3. Right-click in the Output window, and then click Settings.
The Log Settings dialog is displayed.

4. Select the Field Read Commands, Field Write Commands, and Protocol Analyzer options.
5. Click OK to close the Log Settings dialog.

You can now monitor the device I/O during runtime.
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Downloading your project to a Windows Embedded device

This part of the tutorial shows how to download your project to a Windows Embedded device, such as a
plant-floor HMI panel.

After configuring a project and testing it locally (on the development station), you can download it to
a remote station — either a Windows PC that is running IWS or a Windows Embedded device that is
running EmbeddedView or CEView.

1. On the desktop of the remote station, click Start > All Apps > InduSoft Web Studio v8.1 > IWS v8.1 Remote Agent.
The Remote Agent utility runs.

i | Remote Agent (vB.1) >

Connection status:
| Mot connected to remate client |

Log:

Device connection wia Hetwork,  F
[TCRAP)

Setup E =it

[F[=): 192.168.56.1, 172.19.244.145, 10.229. 20

Remote Agent utility
2. Click Setup.
The Setup dialog is displayed.

3. Select the type of connection — Serial, TCP/IP, or Infrared — between the remote station and the
development station.

g Note: For better performance, we recommend that you use TCP/IP whenever possible.

B Setup x
Device Connection
() Serial Port COk1
@ TCRAP Advanced...
Infra Red

[ ata Protection

Jzers. .. Cancel

Selecting TCP/IP on the remote station
4. Click OK to close the Setup dialog, but leave the Remote Agent utility running on the remote station.

5. In the development application, click Connect on the Home tab of the ribbon.
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The Remote Management dialog is displayed.

Remote Management
| Target | 1 Specify and connect to the target host before you can download your project and
!I the run-time

Project

Impart Target Station Disconnect

Embedded License (®) Host: 0.0.0.0 Status:
Serial Port: Advanced Platform:
() Microsoft ActiveSync
nstall system files... | [¥] Only newer files

oK Cancel

Remote Management dialog

6. Select the type of connection to the target (remote) station.
This selection should match the selection you previously made in the Remote Agent utility on the
remote station.

7. If you selected Host, type the host name or IP address of the remote station.

8. Click Connect.
If you successfully connect to the remote station, then information about that station is displayed in
the Status and Platform boxes.

9. If the remote station is a Windows Embedded device, click Install system files.
The system files are installed on the remote station.

10.Click the Project tab.

11.Click Download.
The project files are downloaded to the remote station.

12.Click Run.
Your IWS project is run on the remote station.
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Deploying your project as a web application

This part of the tutorial shows how to deploy your project as a web application, to which remote users can

connect with Internet Explorer.

For Internet Explorer to work as a web thin client, it must install a browser plug-in that "plays" IWS
project screens. If your computer is connected to the Internet, then IE will automatically download the
control from InduSoft's public server when you connect to a project runtime server for the first time.

To deploy your project as a web application:

1. Configure the IP address of the data server.

a) On the Project tab of the ribbon, in the Web group, click Web.
The Project Settings dialog is displayed with the Web tab selected.

Project Settings

Web

] © Define server and client settings, such as firewall and virtual keyboard
i

Data Server IP Address: Send Period (ms): Advanced
| | | 100
IP Security...

Encrypted Channel
[ ] Dizable Remote Client Commands [ ] Aute Screen Scaling
Enable TooMips [ ]Enakle File Compression

Log |:|‘-.-‘irtual Keyboard:

[ ]Enable Keypad

Show Hint:

Buitt-in Dialogs Scale: 100% - Enable Min/Max fields

Enable multi-line text input

Cancel

Web tab of Project Settings dialog

b) In the Data Server IP Address box, type the IP address of the web server.
For this tutorial, type 127.0.0.1, which is the standard loopback address (a.k.a. "localhost").

c) Click OK to close the dialog.

2. Make sure the data server is set to start up when you run your project.
a) On the Home tab of the ribbon, in the Local Management group, click Tasks.
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The Execution Tasks dialog is displayed.

Project Status

Execution Tasks

ﬁ'i}_% Configure and monitor runtime tasks, such as Background Tasks and Viewer

Task

[ g/ Background Task
%rj‘f— Core Runtime

a Catabase Spy

wi Database/ERP Runtime:

’ Driver Runtime
®FHDA OPC Server
ﬂ- LogWin

£ Mobile Access Runtime
! OPC DA 2.05 Client Runtime
2 OPC UA Client Runtime
G OPC UA Server Runtime
#H OPC XMUDA Client Runtime
@G Studio Scada OPCServer
_ﬁ_TCF‘IIF‘ Client Runtime

W TCRAP Server Runtime

[___j Wiewer

Status

Startup

Automatic
Automatic
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Manual
Automatic

Start

Stop

Startup...

Execution Tasks dialog

b) In the list of tasks, select TCP/IP Server Runtime, and then click Startup.
The Startup dialog is displayed.

Startup

Type
(@) arual

() Automatic

pos

Cancel

Startup dialog

c) Select Automatic, and then click OK.

d) Click OK to close the Execution Tasks dialog.

3. Save and close all open screens and worksheets.

4. Click the Application button at the top-left of the development environment, and then click Publish >
Save All As HTML on the Application menu.
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Your project screens are saved as HTML files in the Web sub-folder of your project folder (i.e.,
\<project name>\Web).

. Configure a web server to make the Web sub-folder available to the network.

For this tutorial, use NTWebServer, which is free, lightweight web server program that is included with
the InduSoft Web Studio software. Simply copy it from the InduSoft Web Studio program folder (at
InduSoft Web Studio v8.1\Bin\NTWebServer.exe) to your project's Web sub-folder (at <project
name>\Web), and then double-click the file to run it. It automatically serves the contents of whatever
folder it is in, without any further configuration.

¢ Note: NTWebServer is provided for testing purposes only. It should never be used in a real
production environment or on a secure network.

You can also configure the "root directory" or "home directory" setting of some other web server
program (e.g., Microsoft IIS) to point to the Web sub-folder, or you can copy the Web sub-folder to an
existing web server on your network. The web server (which makes the HTML files available to clients)
and the data server (which actually runs your IWS project and exchanges data with the clients) do not
need to be the same computer.

6. On the Home tab of the ribbon, in the Local Management group, click Run.

7. Open a web browser (e.g., Microsoft Internet Explorer), and then enter the URL address of the synoptic

screen on the web server.

For this tutorial, type http://127.0.0.1/synoptic.html and then press Return. (127.0.0.1 is the
standard IP address for the loopback network interface, a.k.a. "localhost".)

After a few moments, during which the browser downloads and installs the browser plug-in, the
synoptic screen is displayed in the browser.

Notice that you can change the level of any tank either locally using the project viewer or remotely using
the web browser, and changes on one client appear immediately on the other. They work equally well.
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